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READ ME FIRST 

Welcome to Take Control of Running Windows on a Mac, version 
1.0.1.  

Apple’s new Intel-based Macs offer several excellent options for 
running Windows alongside, or even instead of, Mac OS X. Take 
control of Windows on your Mac with this detailed guide that covers 
Apple’s dual-boot software, Boot Camp, as well as third-party virtual-
ization software such as Parallels Desktop and Q. This ebook was 
written by Joe Kissell, edited by Caroline Rose, and published by 
TidBITS Electronic Publishing. 

To get in touch or learn more about the Take Control ebooks, you can: 

• Contact us by sending email to tc-comments@tidbits.com. 

• See About This Ebook to learn about the author and publisher.  

• Read the fine print on the copyright page. 

• Find answers to general questions by reading the FAQ at 
http://www.takecontrolbooks.com/faq.html. 

• Buy another ebook by checking out our Featured Titles or by 
visiting http://www.takecontrolbooks.com/catalog.html. 

The price of this ebook is $10. If you want to share it with a friend, 
please do so as you would with a physical book, meaning that if your 
friend uses it regularly, your friend should buy a copy. The “Help a 
Friend Take Control!” button on the cover makes it easy for you to 
give your friend a discount coupon. 

We may offer free minor updates to this ebook. Click the Check for 
Updates button on the cover to access a Web page that informs you 
of any available or upcoming updates. On that page, you can also 
sign up to be notified about updates via email. 

mailto:tc-comments@tidbits.com
http://www.takecontrolbooks.com/faq.html
http://www.takecontrolbooks.com/catalog.html?14@@!pt=0034-INTERNAL
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Onscreen Reading Tips 
We carefully designed the Take Control ebooks to be read onscreen, 
and although most of what you need to know is obvious, note the 
following for the best possible onscreen reading experience: 

• Blue text indicates links. You can click any item in the Table of 
Contents to jump to that section. Cross-references are also links, 
as are URLs and email addresses. 

• Work with the Bookmarks tab or drawer showing so that you can 
always jump to any main topic by clicking its bookmark. 

• In Adobe Acrobat Pro version 6 or 7, set your preferences to view 
Web URLs in a Web browser: choose Acrobat > Preferences, switch 
to the Web Capture pane, and choose In Web Browser from the 
Open Web Links pop-up menu. 

• Find more tips in the Take Control FAQ on the Web. 

Printing Tips 
Although our layout is aimed at making online reading an enjoyable 
experience, we’ve made sure that printing remains a reasonable 
option. Please review these tips before you print: 

• Use the Check for Updates button on the cover to make sure you 
have the latest version of the ebook and to verify that we don’t plan 
to release a new version shortly. If you want to commit this ebook 
to paper, it makes sense to print the latest possible version. 

• Don’t throw out your PDF after you print! You must click the 
Check for Updates button on the cover to get future updates. The 
link must be accessed from the cover of your PDF. 

• For a tighter layout that uses fewer pages, check your printer 
options for a 2-up feature that prints two pages on one piece of 
paper. For instance, your Print dialog may have an unlabeled pop-
up menu that offers a Layout option; choose Layout, and then 
choose 2 from the Pages per Sheet pop-up menu. You may also 
wish to choose Single Hairline from the Border menu. 

• When printing on a color inkjet printer, to avoid using a lot 
of color ink (primarily on the yellow boxes we use for tips and 
figures), look for an option to print entirely in black-and-white. 

http://www.takecontrolbooks.com/faq.html#reading0
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• In the unlikely event that Adobe Acrobat or Adobe Reader cannot
successfully print this PDF, try Preview; several readers have
solved printing problems by using Preview.

Basics
In reading this ebook, you may get stuck if you don’t know certain
basic facts about Mac OS X or if you don’t understand Take Control
syntax for things like working with menus or finding items in the
Finder. Please note the following:

• Path syntax: This ebook occasionally uses a path to show the
location of a file or folder in your file system. Path text is in bold
type. For example, Mac OS X 10.4 Tiger stores most utilities, such
as Calculator, in the Utilities folder. The path to Calculator is:
/Applications/Utilities/Calculator.

The slash at the start of the path tells you to start from the root
level of the disk. You will also encounter paths that begin with
~ (tilde), which is a shortcut for any user’s home directory. For
example, if a person with the user name joe wants to install
fonts that only he can access, he would install the fonts in his
~/Library/Fonts folder, which is just another way of writing
/Users/joe/Library/Fonts.

• Menus: When I describe choosing a command from a menu
in the menu bar, I use an abbreviated description. For example,
the abbreviated description for the menu command that provides
information about a file in the Finder is “File > Get Info.”

What’s New in Version 1.0.1
Version 1.0.1 is a minor release that includes corrected and expanded
information on renaming Windows volumes (see the tip Rename Your
Windows Volume, on page 46), as well as a few small typographical
corrections.

If you printed version 1.0 and wish to re-print the changed pages,
you should re-print and swap in these pages: 4, 19, 46, and 64.
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INTRODUCTION 

Anyone who knows me will tell you I’m a Mac fan through and 
through. As I type this, I can see six Macs within a radius of 10 feet 
in my home office (and that doesn’t count the Xserve I have sitting 
in a rack at a data center). I’ve written oodles of articles, books, and 
ebooks about Mac software, and for the past dozen years or so most 
of my income has resulted, in one way or another, from my work with 
Macs. If I had a nickel for every time someone referred to me as “the 
Mac guy,” I could retire today. 

And yet, although I’ve always been candid about my preference 
for Macs, I’m well versed in Windows, too; for years, I was deeply 
involved in developing and testing software for both platforms. 
Whether it’s performing an exorcism on someone’s virus-infected PC 
or walking a friend through a fiddly troubleshooting procedure over 
the phone, I know my stuff. Partly because I understand Windows so 
well, I’d always opt for a Mac if given the choice. But the reality is that 
I don’t always have that choice. Like it or not, some things I want to 
do with my computer still require Windows. Even when working on 
something platform-neutral, such as a Web site, I have to be sure 
things look and work correctly on Windows, since the majority of 
my site’s visitors will probably be Windows users. 

On those occasions when I’ve needed Windows over the past few 
years, I’ve tried everything from running Virtual PC to visiting a 
library or cybercafé—everything, in other words, short of buying a 
Windows PC. That was the one step I hoped never to take, but other 
solutions were frequently awkward, slow, or otherwise annoying. 
Now, thanks to the Intel Mac sitting on my desk, I can have my cake 
and eat it too. I get the Mac OS X environment I love, plus a fast, fully 
featured Windows installation, all in one box. I can even share files 
and network connections between operating systems seamlessly. And 
it wasn’t even expensive. (Although this ebook focuses mainly on run-
ning Windows on an Intel-based Mac, you can also get Windows to 
run on a Mac with a PowerPC processor; see Appendix A: Windows 
on a PowerPC Mac.) 

Achieving this state of computing bliss did require overcoming some 
time-consuming hurdles, however. For example, I had to figure out 
the pros and cons to using Apple’s Boot Camp software versus third-
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party products such as Parallels Desktop and Q. I had to find a way 
to create a Windows CD that had Service Pack 2 already integrated, 
even though my boxed retail copy of Windows was manufactured long 
before SP2 existed. I had to determine why my Mac mini refused to 
use a feature built into its processor that was designed to enhance the 
performance of virtual machines (software environments in which 
one operating system runs within another). And I had to make edu-
cated guesses about numerous configuration options that were docu-
mented poorly (or not at all). In all, the process involved a lot more 
time, confusion, and anxiety than I would have liked. 

Having wrestled with all these issues and more, I’d like to save you 
all that effort and offer you a set of easy-to-follow instructions. In this 
ebook, I tell you everything you need to know about your options for 
running Windows on a Mac, how to get around common annoyances, 
and what you should do to protect yourself from the big, bad world 
of Windows malware. 

One thing I spend very little time on here is how to use Windows 
itself; I assume a basic familiarity with such features as the Start 
menu and Windows Explorer. If you’ve never used Windows before, 
you’re bound to be somewhat disoriented, and in that case I recom-
mend picking up one of the books listed in the Learn More section. 

As I write this, Intel Macs have been shipping for just a few months. 
Apple’s Boot Camp software is still in beta testing and Parallels 
Desktop has not yet reached its final release stage. Pundits are mak-
ing all sorts of predictions about new options for running Windows 
that might appear in Mac OS X 10.5 Leopard. And Microsoft is still 
claiming that they’ll ship their new Windows Vista operating system 
at some point in this century. In short, the whole Windows-on-Mac 
situation is still in a state of flux. The story may be very different 
weeks or months down the road. As the facts change, I’ll update this 
ebook with the latest information. You can stay on top of recent 
developments by clicking the Check for Updates button on this 
ebook’s cover. 



Page 7 

QUICK START 

You need not read this ebook straight through; most people will pick 
one method for running Windows and just read the relevant sections. 
But be sure not to skip Decide How to Run Windows, which provides 
important background information. 

Make initial preparations: 

• Find out if adding Windows to your Mac is for you: Read Why 
Bother? for guidance. 

• Determine whether the best approach is to install Boot Camp or 
Virtualization Software in Decide How to Run Windows. 

• Regardless of which method you choose, Collect the Ingredients 
you’ll need to install and use Windows. 

If you decide to go with Boot Camp: 

• Learn how to Install and Use Boot Camp. 

• Overcome common annoyances with mice and keyboards. Read 
Solve Input Device Problems. 

If you choose virtualization software: 

• Read Install and Use Parallels Desktop or Install and Use Q. 

Solve irritating problems: 

• If you have a pre–Service Pack 2 Windows CD, bring it up to date 
without breaking the bank. Read Create a Slipstream Installer 
Disc. 

• Regardless of how you install Windows, you’ll want to keep it safe 
from viruses, spyware, and other malicious software. See Protect 
Your Windows Setup from Malware. 

Go further: 

• Discover additional resources about Windows in Learn More. 

• Find out how to run Windows (sort of) on a Mac without an Intel 
chip in Appendix A: Windows on a PowerPC Mac. 
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WHY BOTHER? 

Most of the people reading this ebook are probably Mac users who 
nevertheless have a need or desire to use Windows in some circum-
stances. However, you may also be a Windows user who’s been 
tempted by the Mac but wants to know how hard it will be to use both 
operating systems on the same computer. You already know why you 
want to use Windows, and the question is what you gain by running 
it on a Mac.  

If you’re a Mac user already, you presumably feel that a Mac can 
meet the majority of your computing needs. And of course millions 
of people—including serious computer geeks, such as yours truly—get 
by quite happily without having a Windows machine on their desks. 
So you may be wondering: why would an otherwise sane person 
choose to run Windows on a Mac? Never mind that it’s possible, 
or even easy; is it something you should do? 

For years, Mac users have had to face the frequently voiced complaint 
that “Windows has far more software available.” To some extent, that 
claim is misleading; sure, there are more individual Windows pro-
grams than Mac OS X programs (especially if you count viruses!), but 
that doesn’t mean there are more useful or necessary Windows pro-
grams. (Does it really matter that Windows may have 27 different 
niche word processors or 305 versions of Breakout?) There are Mac 
equivalents of almost every major Windows application, including 
the big programs from developers like Microsoft, Adobe, Quark, and 
FileMaker. Apple and third-party developers make lots of fantastic 
programs for Mac OS X that have no Windows analogs. And Mac users 
have access to a vast array of software written for Unix. So in truth, 
there are very few things you can do on Windows that you can’t do 
(and maybe even do more easily) on a Mac. 

And yet, a few annoying exceptions remain. Here are some of the top 
reasons you might need to resort to Windows after all: 

• Games: I’ve been told that many people enjoy playing games on 
their computers. I must try this one day. Rumor has it that some 
of the more popular games run only under Windows. 
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• Interactive DVDs: I have at least half a dozen DVD movies that 
feature enhanced content that requires a computer, and the labels 
explicitly state that these features don’t work on Macintosh com-
puters. But I can use them on my Intel Mac running Windows. 

• Windows Web Browsers: Every once in a while, you may 
run across a Web site that was designed expressly to require a 
Windows browser, usually Internet Explorer. Sometimes you can 
get these sites to work on a Mac by switching to a different browser 
or tweaking hidden settings to fool the site into thinking you’re 
using a Windows machine, but these tricks won’t get you into every 
site, especially not those that use ActiveX to provide important 
functionality. And if you design Web sites yourself, you may want 
to preview your site in Windows browsers, which sometimes 
display pages much differently than Mac browsers. 

• Microsoft Outlook: Even though Entourage and Mail can  
communicate with Microsoft Exchange servers, they don’t offer 
the full range of features in Microsoft Outlook, and in some 
corporate environments, using Outlook for email and scheduling 
is mandatory. 

• Microsoft Access: This database application has no Mac 
equivalent. If you don’t want to go to the effort of reworking your 
databases in FileMaker Pro or another Mac database, you’ll 
appreciate having access to Access. 

• Microsoft Project: Several excellent project management 
applications exist on the Mac, most of which can seamlessly read 
and write Project files. But in some cases, simply running Project 
under Windows may be the path of least resistance. 

• Dragon Naturally Speaking: One area in which the Mac still 
falls way behind Windows is speech recognition. Dragon Naturally 
Speaking is far more accurate and powerful than any tool currently 
available for Mac OS X, and if you need to dictate large volumes of 
text to your computer, you’ll appreciate being able to run this 
software. 

• QuickBooks: Intuit does sell a Mac version of this small-business 
accounting package, but it’s widely regarded as inferior to the 
Windows version, especially when it comes to payroll processing. 
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• Quicken online banking: For personal accounting, Quicken 
also comes in versions for both Windows and Mac OS X. But a few 
banks prevent the Mac version of Quicken from accessing account 
data online. If you have an account with such a bank, it may be 
easier to run Quicken under Windows than switch to another 
institution or application. 

• FrameMaker: Often considered the best publishing tool for long 
or complex documents, FrameMaker is currently available for 
Windows or Unix—but not Mac OS X. (Adobe did sell a Mac OS 9 
version for years, but that’s been discontinued.) 

• ExamSoft: Some educational institutions (notably law schools) 
require students to use this software for taking exams. It runs only 
on Windows, and the company has stated unequivocally that there 
will never be a Mac version. 

• Grants.gov: If you’re applying for a U.S. government grant on-
line, you may have trouble doing so from a Macintosh. Although 
the site has limited workarounds in place for Mac users and is 
reportedly working on a better long-term solution, you’ll still 
have a much quicker and less frustrating experience if you use 
Windows—at least for the time being. 

• Library catalog software: People who work in a library and 
want to access its online catalog system may need to run a 
Windows-based client. 

• Internal corporate software: Numerous companies develop 
special applications for internal use only, and if the company has 
standardized on Windows, chances are the software will be 
Windows-only. 

• PDA software: Whether you have a Palm- or Windows Mobile– 
based PDA or smartphone, you may find synchronization support 
to be much better under Windows than under Mac OS X, even 
if you add a third-party product such as The Missing Sync 
(http://www.markspace.com/). In addition, installers for some 
PDA applications are packaged as Windows executable files. 

http://www.markspace.com/
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Sad though it may be, I could go on and on with other examples of 
software that currently excludes Mac users. In an ideal world (or at 
least a nearly ideal world that still contains Windows!), all software 
would be cross-platform, but that day, if it ever comes, is far in the 
future. 

In the meantime, if you need to run Windows for reasons such as 
these, you may well ask, “Why not just buy a Windows PC instead?” 
You may be asking a similar question if you’re a Windows user 
considering switching to the Mac. 

I can think of many reasons to opt for a Mac, but the biggest is that 
an Intel-based Mac gives you the best of both worlds. You can use 
Mac OS X most of the time, benefiting from its stability, security, and 
ease of use (not to mention Apple’s fantastic industrial design and all 
that great Mac-only software, such as iLife and iWork) and still have 
access to Windows-only capabilities when you truly need them. The 
cost of adding Windows to an Intel Mac is less than that of buying a 
reasonably powerful stand-alone Windows PC. With Windows run-
ning on your Mac, you’ll save desk space, reduce power consumption, 
and be able to share files between platforms more easily. 

Once you’ve made the decision to put Windows on your Mac, the next 
thing to figure out is which of several methods you should use to do 
so. Each approach has its pros and cons. I explore your options in the 
next section. 
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DECIDE HOW TO RUN WINDOWS 

Broadly speaking, you can use either of two approaches to run Win-
dows on an Intel Mac: dual-boot (using Apple’s Boot Camp software) 
or virtualization (using third-party software such as Parallels Desktop 
or Q). In this section I describe these two approaches and help you 
choose which path to take; I also describe the two major virtualization 
options in some detail. 

Boot Camp 
Apple’s Boot Camp software (http://www.apple.com/macosx/ 
bootcamp/, currently in public beta testing) enables you to divide the 
hard disk of an Intel Mac into a Mac OS X partition and a Windows 
partition, install Windows XP onto the Windows partition, and 
choose either partition as your computer’s startup volume. Then, 
after choosing the Windows partition, you can run Windows XP 
on the Mac just as if you were running it on a PC.  

The main thing to keep in mind about Boot Camp is that when you 
use it, you have to make a choice: at any given time, your Mac is run-
ning either Mac OS X or Windows, but not both. Depending on which 
options you choose, you may or may not be able to see your Mac’s 
files when running under Windows (and vice versa). But while run-
ning Windows you won’t be able to use any of your Mac software, 
and while running Mac OS X you won’t be able to use any Windows 
software. 

Boot Camp offers some benefits over virtualization software: 

• With Boot Camp, Windows has access to all the RAM installed 
in your computer—more than it would if Mac OS X were also 
running. 

• The performance of Windows, and particularly of graphics, is 
somewhat higher; the difference is especially noticeable in games. 

• Boot Camp was designed and tested by Apple for use on their 
computers, and is likely to be well supported in future versions of 
Mac OS X. 

• It’s free. (In the future, it may be available only as part of 
Mac OS X 10.5 Leopard, but for now, if you already have Tiger, 
it’s free.) 

http://www.apple.com/macosx/bootcamp/
http://www.apple.com/macosx/bootcamp/
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On the other hand, although the situation may change with later 
versions of Boot Camp (or with Leopard), Boot Camp also imposes 
some limitations, including these: 

• Unlike virtualization systems, Boot Camp does not currently 
support installation of any version of Windows other than 
Windows XP, SP2; you can’t, for example, use Windows 98 or 
Windows 2000. (You can, with some hacking, install certain 
distributions of Linux, but this ebook is only about Windows.) 

• Some peripherals won’t work, including iSight cameras, Apple 
Remotes, Bluetooth keyboards and mice, and Apple USB Modems. 

• Even if you plug in headphones or external speakers, all sound will 
come through your Mac’s built-in speaker(s). 

• Using an Apple keyboard, you may not be able to enter certain 
characters, such as the euro (€) symbol, or perform a Print Screen 
command, without special procedures (see Type special characters 
and Take screen captures, later). 

In addition, the process for installing Boot Camp can be somewhat 
cumbersome, and more so if you have a Windows CD without SP2. 
(I get into these details later in Install and Use Boot Camp.) 

All things considered—especially keeping in mind that Boot Camp is 
still incomplete—these are not serious trade-offs. The most significant 
factors you should think about when deciding whether to use Boot 
Camp are whether you need every last ounce of performance possible 
while running Windows, how quickly you’ll want to switch between 
operating systems, and the extent to which you’ll use files from one 
OS while working in the other. (See Joe’s Recommendations, ahead, 
for more information.) 

Virtualization Software 
If you’ve been a Mac user for any period of time, you’ve probably 
heard of a product called Virtual PC (once published by Connectix, 
and now owned by Microsoft). With this software installed on your 
Mac, you can install Windows (or another operating system) and run 
it inside a window on your (PowerPC-based) Mac. 
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Any program that provides a way for one operating system to work 
within another can be called virtualization software. When virtual-
ization software is running, the environment it creates for another 
operating system is called a virtual machine, and an operating system 
that runs inside that virtual machine is called a guest operating sys-
tem (to distinguish it from the main OS the computer is running, 
called the host operating system). 

But Virtual PC is also an emulator—that is, software that simulates 
specific hardware so that a CPU can run a different OS than the one 
it was designed for. Because the Mac’s CPU has to do its own work 
while also mimicking a completely different type of processor, 
Windows running within Virtual PC on a PowerPC Mac is invariably 
quite slow. 

Intel Macs have the same type of CPU as PCs, so processor emulation 
is no longer necessary. However, to run Windows within Mac OS X, 
you still need a virtual machine. One reason is that apart from the 
CPU, there are still other hardware differences between Macs and PCs 
and thus other hardware components that must be emulated. Another 
reason is that Windows expects to have direct access to your hard-
ware, but the host OS (Mac OS X in this case) controls the hardware. 
A virtual machine tricks the guest OS into believing it has direct 
access to the machine’s CPU and other hardware, and it emulates 
any physical devices (such as sound cards) that might be different 
between platforms. 

When Apple announced the transition to Intel chips, conventional 
wisdom held that Microsoft would quickly adapt Virtual PC to provide 
virtual machines for Windows on Intel Macs. After all, it should be 
easier than what they had to do before, since the emulation problem 
is gone. However, for reasons known only to Microsoft, no version of 
Virtual PC for Intel Macs exists yet. (Microsoft does still sell Virtual 
PC for PowerPC Macs; see Appendix A: Windows on a PowerPC Mac.) 
Luckily, other developers have taken on the challenge, and you can 
now choose from two virtualization tools that enable you to run 
Windows within Mac OS X on an Intel Mac: Parallels Desktop and Q. 
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Both tools share several basic features: you can install and run multi-
ple operating systems (even at the same time); you can run a guest OS
in its own window or in full-screen mode; you can share files between
the host OS and the guest OS; much of the hardware attached to the
computer is available to the guest OS; you can pause (or “suspend”) a
guest OS, saving its state so that you can quit the virtualization appli-
cation but then retrieve it quickly with everything just as you left it
(somewhat like putting a Mac to sleep and waking it up); and you can
move the disk image containing your entire Windows environment to
another Intel Mac if necessary and run it there without modification.
Beyond these superficial similarities, though, the two programs differ
in several important respects.

Parallels Desktop
This commercial application costs a mere $50 (and you can save $10
by using the coupon at the end of this ebook); you can find it at
http://www.parallels.com/en/download/desktop/. After installing
it, you can set up a virtual machine for Windows (or the OS of your
choice) in a matter of minutes. You can then install Windows within
the virtual machine just as though you were installing it on a PC.
Parallels Desktop offers a variety of settings that enable you to tailor
its performance and options to your liking. Even though the Mac
version of this product is new, Parallels Desktop has a polished feel
and is generally robust. Better yet, it’s fast. Running Windows XP
within a Parallels Desktop virtual machine is almost as fast as booting
directly into Windows XP using Boot Camp, and the performance is
certainly zippy enough to make it comfortable to use for most day-to-
day tasks. I have yet to encounter any Windows software that would
not run acceptably in a Parallels virtual machine.

Nevertheless, the software is still incomplete as I write this; it has
some bugs, and some features are not yet available. For example,
Parallels Desktop does not yet support burning CDs or DVDs; Fire-
Wire devices do not work; and some USB devices do not work (or do
not work at full speed). In addition, the software does not currently
emulate a 3D graphics card, so if you want to run a game or other
graphics-intensive application that requires hardware 3D support,
Parallels is out for the time being. But given the rapid development
progress I’ve seen, I expect most or all of those difficulties to evap-
orate soon.

http://www.parallels.com/en/download/desktop/
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Q
Unlike Parallels Desktop, Q (http://www.kberg.ch/q/) is a free, open-
source application, based on an emulation program called QEMU.
One interesting aspect of Q is that it also works on PowerPC-based
Macs (though very slowly); see Appendix A: Windows on a PowerPC
Mac. And, of course, the price is right. Basic installation, setup, and
usage are nearly as easy with Q as with Parallels Desktop.

Like Parallels, Q hasn’t yet reached its final release stage—in fact,
it’s further behind in development (currently in the “alpha” stage)
and has greater limitations. For example, Q currently offers no way
to transfer the contents of a Clipboard between guest and host oper-
ating systems, networking options are more limited, and fewer USB
devices work correctly. Worse, in my testing, I found that Windows
XP under Q runs roughly half as fast as it does under Parallels; I’d
call it usable for basic tasks, but barely so. Q’s user interface, docu-
mentation, and operation show many rough edges.

On the other hand, Q does offer several different choices of video and
sound card emulations, and it has two other particularly intriguing
features: it can import Virtual PC disk images, potentially saving a
great deal of setup time, and it can download and install prebuilt disk
images for numerous other open-source operating systems (mostly
Linux variants).

Joe’s Recommendations
Having used both Boot Camp and virtualization software, my feeling
is that there’s no contest at all: virtualization is the way to go, and
between Parallels Desktop and Q, the former is significantly superior
in almost every way—well worth the $50 it costs ($40 with the
coupon). Bear in mind that I say this as a non-gamer, and as someone
who needs to switch rapidly and seamlessly between Mac OS X and
Windows. But I found the performance of Windows under Parallels
Desktop to be plenty fast for all my needs (and close enough to its
performance under Boot Camp that I couldn’t tell the difference, at
least for non-graphics-intensive applications, without running
benchmarking software). The convenience of being able to switch into
Windows in a matter of seconds, easily transfer files between systems
in real time, and use all my standard peripherals makes the
experience of running Windows as pleasant as possible.

http://www.kberg.ch/q/
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Still, you might choose Boot Camp if you run Windows primarily for 
games (and I don’t mean Solitaire!), if you intend to use Windows for 
discrete tasks or projects that require no interaction with Mac OS X 
or your Mac files, if you need features not yet available in Parallels 
Desktop (such as CD/DVD burning), if you need to use hardware for 
which only Windows drivers are available, or if you have some impor-
tant reason to keep your Windows and Mac environments strictly 
segregated from each other. One obvious reason to keep them sepa-
rate is to protect your Mac files from Windows malware. (Even 
though you will undoubtedly follow all the advice in Protect Your 
Windows Setup from Malware, you can never be too careful.) 

As free software, Q obviously has the edge in pricing over Parallels 
Desktop. And, since Q is open-source software, it’s somewhat less 
susceptible to the vicissitudes of the market that can affect commercial 
applications. I would not be at all surprised to see Q’s performance 
and feature set improve dramatically in the coming months, in which 
case it may become the ideal choice. But for now, I find it hard to 
make a good case for choosing Q over Parallels Desktop. 

  
NOTE In an ideal world, you could run both Boot Camp and virtual-

ization software using a single Windows installation, switching 
to whichever environment is best at any given time. Currently, 
however, this is not possible, and though Parallels claims to be 
investigating a way to do this in the future, using one copy of 
Windows in two different environments—even though they’re 
part of the same physical machine—may violate Microsoft’s End 
User License Agreement. However, nothing prevents you from 
installing two separate, individually licensed versions of Windows 
on a computer: one using Boot Camp and the other using 
virtualization software. 
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COLLECT THE INGREDIENTS 

Before you can begin setting up Windows on your Mac, be sure you 
have the necessary hardware, software, and other materials. 

An Intel Mac (Preferably) 
If you have a Mac with an Intel processor (in other words, any new 
model introduced in 2006 or later), you have several great options for 
running Windows at (virtually) full speed, and I spend the bulk of this 
ebook describing those options. If you have an older, PowerPC-based 
Mac, you can still choose from among at least three different methods 
of running Windows (see Appendix A: Windows on a PowerPC Mac), 
but I can’t recommend any of them earnestly. The performance of 
Windows running on an Intel Mac is generally superb, nearly match-
ing (and in some cases surpassing) the performance on a PC with 
equivalent processor speed. On a PowerPC Mac, however, the perfor-
mance of Windows ranges from sluggish (at best) to almost unusably 
glacial (at worst). If at all possible, therefore, obtain an Intel-based 
Mac; you can find a Mac mini for as little as $600, and in my opinion 
it’s money well spent. 

  
NOTE If you regularly use software that is not yet available as a 

Universal Binary (so that it runs natively on an Intel Mac), you 
might want to keep your old Mac around for a while. Although 
Intel Macs are generally faster than PowerPC Macs, some older, 
non-Universal programs still run faster on a PowerPC processor. 

  
Not sure whether your Mac has an Intel chip or a PowerPC chip? 
Choose About This Mac from the Apple menu. In the window that 
appears, next to the word “Processor” (see Figure 1), you’ll see the 
speed and type of processor (either Intel or PowerPC). 
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Figure 1

  

The About This Mac window as it appears on a PowerPC Mac (left)
and an Intel Mac (right).

Disk Space
All the Windows environments for Macs require a substantial amount
of empty disk space, although the amount varies considerably depend-
ing on which software you’re using, which version of Windows you
have, how many Windows applications you intend to install, and other
factors. Apple requires at least 10 GB free for Boot Camp; for virtual-
ization software, 5 GB of free space is a bare minimum (and more
is better).

NOTE Under Boot Camp, whatever size you make your Windows parti-
tion, that’s the size you’re stuck with. But with Parallels Desktop
and Q, the disk images you create can grow dynamically. So be
sure you have more disk space available than the size of the
virtual disk you start with.
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RAM 
If you’re planning to use Boot Camp, Windows will have access to all 
the RAM installed in your computer. Since no Intel Mac ships with 
less than 512 MB of RAM, that should be plenty. 

However, if you’re going to be using Windows in a virtualization 
environment, you must have enough RAM for Mac OS X as well 
as Windows, since both will be running at the same time. Microsoft 
recommends a minimum of 128 MB of RAM for Windows XP, but it 
runs better and faster with more; I’d suggest 256 MB as a more 
realistic minimum. Likewise, Mac OS X 10.4 Tiger requires a mini-
mum of 256 MB, but again, you’ll find performance much better with 
512 MB or more. In short, if your computer has only 512 MB of RAM 
in total, both Mac OS X and Windows will be a bit squeezed. Upgrad-
ing your computer to 1 GB or more will give you more breathing room 
for both operating systems. 

A Windows CD 
Neither Boot Camp nor Parallels Desktop includes a copy of Win-
dows; these applications merely provide an environment in which 
you can install and run Windows. So you’ll need a Windows CD. 

  
NOTE Boot Camp works with Windows XP (Home or Professional; 

see http://www.microsoft.com/windowsxp/home/howtobuy/ 
choosing2.mspx for a list of differences between the two edi-
tions). The virtualization environments I discuss here work with 
other versions of Windows as well, in addition to Linux and 
numerous other operating systems. Unless otherwise noted, 
assume that all instructions here refer to Windows XP and that 
they apply equally to the Home and Professional editions. 

  
The easiest way to obtain a copy of Windows is to visit your favorite 
(online or brick-and-mortar) computer store and pick up a retail box. 
Expect to pay $200 for Windows XP Home or $300 for Windows XP 
Professional. Web searching may turn up some discounts, but be 
aware that quite a few shady characters are selling unofficial versions 
of Windows online, and you do not want to incur Microsoft’s wrath 
just to save a bit of money. 

http://www.microsoft.com/windowsxp/home/howtobuy/choosing2.mspx
http://www.microsoft.com/windowsxp/home/howtobuy/choosing2.mspx
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I’m speaking in particular of so-called OEM distributions of Windows, 
which you can find all over the Web at tempting prices. Microsoft 
provides Windows CDs (without a box or manual) to original equip-
ment manufacturers (OEMs) for inclusion with new computers. But 
the license for this sort of CD explicitly states that it can be sold only 
with a complete computer, so any vendor that sells it separately is 
violating Microsoft’s policies. You should avoid OEM CDs, however 
attractive they may appear. 

  
NOTE Purchasing an OEM CD could work if you buy it with a complete 

computer system in pieces from a retailer or even from a friend 
who sells parts out of her garage. In these cases, you can 
effectively become your own OEM, although you have to comply 
with a different license: the System Builder agreement 
(http://www.microsoft.com/oem/sblicense/default.mspx). 
Newegg.com (http://www.newegg.com/), for instance, sells this 
OEM license, for a bit less than half of the full retail price for a 
single-user license of either Windows XP Home or Windows XP 
Professional. A reporter colleague of mine confirmed with 
Microsoft that Newegg.com and other firms legitimately sell 
these System Builder–licensed OEM copies, but they are sup-
posed to sell them only with a complete system. The System 
Builder license requires the purchaser to install the OEM copy 
only on a new computer, and to provide technical support 
(among other requirements). 

Purchasing a System Builder–licensed OEM copy by itself is 
clearly against Microsoft’s stated licensing policies; Microsoft 
could deem the license invalid and use their activation system 
to disable your copy if they chose to do so. Thus, all things 
considered, I still recommend strongly against purchasing 
OEM copies of Windows. 

  
On the other hand, if you work for an employer enrolled in the 
Microsoft Software Assurance program, you may be able to purchase 
a full, legal copy of Windows XP through your company at a substan-
tially reduced rate. Likewise, if you’re a student or teacher, you can 
probably get an academic version of Windows XP at a discount by 
providing a dealer with your credentials. It doesn’t hurt to explore 
options like these, but I urge you to avoid any way of obtaining 
Windows that seems suspicious. 

http://www.microsoft.com/oem/sblicense/default.mspx
http://www.newegg.com/
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NOTE Be sure you’re buying a full copy of Windows XP and not merely 

an upgrade package for owners of earlier versions of Windows— 
unless you have an installation CD for an earlier version and are 
willing to go through the installation and upgrade process under 
virtualization software. 

  
Speaking of which, you may be tempted to reuse a copy of Windows 
that came with an old PC. Before you do, carefully read the license 
agreement that came with that copy of Windows. In general, copies 
of Windows shipped with computers are licensed only for those com-
puters and may not be installed on other machines. Microsoft offers 
a variety of licenses for Windows. Some (typically, corporate volume 
licenses) expressly permit installation on multiple machines, but 
most don’t. 

Similarly, if you have a copy of Windows that came with Virtual PC, 
look carefully at the license agreement included with it. It likely says 
that the copy of Windows included with Virtual PC may be used only 
under Virtual PC, and not in any other context. (Depending on when 
and how you obtained Virtual PC, it may not even have a separate 
Windows installation disc; Microsoft uses this strategy partly to 
discourage unauthorized use of the software.) 

Technical limitations also come into play if you try to circumvent 
the terms of your Windows license or use an illegitimate copy. Unlike 
Mac OS X, Windows XP requires not only a serial number (called 
a Product Key) but also an online activation process that ties your 
Product Key to one particular hardware configuration. These two 
steps together enable Microsoft to reduce piracy, and if your copy of 
Windows has already been installed and activated on one computer, 
you may be unable to use it on a second machine even if you were 
disposed to ignore the terms of the license. 

  
NOTE If you buy a new copy of Windows XP today, it will almost 

certainly include Service Pack 2 (SP2). However, if you’re using 
an older copy of Windows XP, you’ll have to create a new CD 
with SP2 integrated before you can install it under Boot Camp. 
See Create a Slipstream Installer Disc for instructions. 
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INSTALL AND USE BOOT CAMP 

Apple offers a 17-page PDF guide to setting up Boot Camp 
(http://images.apple.com/macosx/bootcamp/pdf/Boot_Camp_Beta
_Setup_Guide.pdf), which, interestingly, contains considerably more 
detail than they provide for installing or upgrading Mac OS X. The 
setup guide (which is included with the Boot Camp Assistant software 
and is also downloadable separately) is reasonably complete, accu-
rate, and well written. Much of what follows in this section reiterates 
Apple’s recommended steps; however, I’ve also included some notes, 
warnings, and clarifications about issues I found confusing as I 
worked through several Boot Camp installations myself. 

Important: Make sure you’ve set aside enough time for the entire 
process before starting. I recommend allowing at least 2 hours, of 
which one will be spent mostly waiting for Windows Setup to install 
all its files. 

Assemble Your Tools 
If you followed the instructions earlier in Collect the Ingredients, you 
already have an Intel Mac (a necessity for Boot Camp) with adequate 
RAM and disk space, as well as a Windows XP SP2 disc (see Create a 
Slipstream Installer Disc if you have an earlier version). In addition, 
for Boot Camp, you’ll need the following: 

• A copy of the Boot Camp Assistant software. Download this from 
http://www.apple.com/macosx/bootcamp/publicbeta.html. 

• A blank recordable CD or DVD (in addition to the slipstream CD 
you may have burned earlier). You’ll use this to create a Macintosh 
Drivers disc, which will enable Windows to use certain Apple 
hardware components (see Install Mac Drivers for Windows). 

• A keyboard and mouse (or other pointing device) that do not use 
Bluetooth. If you’re installing Boot Camp on a MacBook Pro, the 
built-in keyboard and trackpad will work; for a desktop Mac, use 
a wired USB keyboard and mouse. (Even though Boot Camp sup-
ports some kinds of Bluetooth devices, keyboard support is limited 
and mouse support is nonexistent. You can install Boot Camp 
using Bluetooth input devices, but once you restart from the 
Windows CD, you’ll be stuck.) 

http://images.apple.com/macosx/bootcamp/pdf/Boot_Camp_Beta_Setup_Guide.pdf
http://images.apple.com/macosx/bootcamp/pdf/Boot_Camp_Beta_Setup_Guide.pdf
http://www.apple.com/macosx/bootcamp/publicbeta.html
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Prepare Your Mac 
Before installing Windows XP, you must make sure your hard disk 
is properly configured and that the Mac has the necessary firmware, 
operating system, and software available. Follow these steps: 

1. Back up your computer: Because you’re about to run software 
that will alter both your firmware and the structure of your hard 
disk, you run a risk of losing data if an error occurs (or if, say, the 
power goes out halfway through the process). So, unless you’re 
starting with a brand new Mac that has none of your own files and 
software on it, stop right now and do a full backup. In this case, the 
best type of backup is a bootable duplicate, in which you copy the 
entire contents of your disk onto an external hard drive. If you 
need guidance in creating a duplicate, see my ebook Take Control 
of Mac OS X Backups. 
http://www.takecontrolbooks.com/backup-macosx.html 

2. Check your hard disk for errors and proper configuration:

a. Insert your Mac OS X Install DVD. 

b. Restart your computer, holding down the C key to force it to 
boot from the optical drive. 

c. After your computer restarts, click through the language 
selection screen. 

d. When the installer window appears, choose Utilities > Disk 
Utility. 

e. In the list on the left side of the window, select your main 
startup volume. 

f. On the First Aid tab, click Repair Disk. 

g. With your startup volume still selected, look for the Enable 
Journaling button on the toolbar. If the button is not dimmed, 
click it to enable journaling. 

h. Quit Disk Utility and allow your Mac to restart normally from 
its hard drive. 

http://www.takecontrolbooks.com/backup-macosx.html?14@@!pt=0034-INTERNAL
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3. Verify that your Mac is running Mac OS X 10.4.6 or later: 
Choose About This Mac from the Apple menu; the version number 
appears just below the words “Mac OS X.” If you have an earlier 
version of Tiger installed, choose Software Update from the Apple 
menu, select the latest version of Mac OS X, and click Install. 

  
TIP If you have a slow Internet connection and need to download the 

10.4.6 update (or, for that matter, the Windows XP SP2 update), 
consider visiting a cybercafé or library, downloading the updates 
there, and burning them onto a CD or copying them to a USB 
flash drive. 

  
4. Update your computer’s firmware: (As of late May 2006, 

Apple had released firmware updates for the Intel iMac, MacBook 
Pro, and Mac mini models.)  

a. Go to http://www.apple.com/support/downloads/ and, in 
the Search field, enter the Mac model you have and the word 
firmware (for example, iMac firmware). Click the magni-
fying glass button to search. 

b. Download the latest firmware update for your computer. 

Special note: Your computer may have more than one 
firmware update available, and if so, you should download 
and install them all. In some cases, later firmware updates do 
not incorporate all the changes of earlier ones. For example, in 
May 2006 Apple released System Management Control (SMC) 
firmware updates for the MacBook Pro, iMac, and Mac mini; 
these updates do not include the fixes found in the firmware 
updates released a month earlier, and are not sufficient, by 
themselves, to enable Boot Camp to run. 

http://www.apple.com/support/downloads/
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c. Run the installer and follow the instructions that appear. The 
exact procedure may vary slightly depending on which model 
you have, but in general, you first run an installer that places 
the firmware updater on your computer; when you quit that 
installer, the updater itself runs automatically. In the updater, 
you click a Shut Down button in the installer and then, after 
your computer is off, you press and hold its power button for 
several seconds until the power light flashes. The update then 
begins; a status bar shows the progress. After the update is 
finished, your Mac restarts normally. 

  
NOTE Apple provides no easy way to tell whether your computer 

already has the latest firmware; the Boot ROM Version shown in 
System Profiler follows a completely different numbering scheme 
from the downloadable updates. If in doubt, simply follow this 
procedure and attempt to update it. If your computer already 
has the version of firmware contained in the update, a message 
will appear that says “This computer does not need this update.” 

  
5. Make sure your hard disk has just one partition: All Macs 

ship with their hard disks configured as a single volume, but you 
can split it into two or more volumes, called partitions, using Disk 
Utility or third-party utilities. In fact, the Boot Camp software 
itself divides your disk into a Mac partition and a Windows parti-
tion. However, the Boot Camp software won’t work if your disk 
is already partitioned. If you’ve already partitioned your disk, you 
must back it up, erase it, reformat it as a single partition, and then 
restore the files from your backup. For detailed instructions, see 
http://docs.info.apple.com/article.html?artnum=303597. 

Take note: When Boot Camp adds a Windows partition to your 
drive, it does so without erasing your existing files (normally, 
repartitioning requires erasing the entire disk). That’s not to say 
you shouldn’t take the precaution of backing up first, though. 

http://docs.info.apple.com/article.html?artnum=303597
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6. Run the Boot Camp Assistant installer: Double-click the 
BootCampAssistant file in the disk image you downloaded and 
follow the instructions. This installer places an application called 
Boot Camp Assistant in /Applications/Utilities; you’ll use 
it in the next section to prepare your computer for its Windows 
installation. 

Your computer is now ready for Boot Camp to be configured, after 
which you can install Windows XP. 

Run Boot Camp Assistant 
Now you’ll run Boot Camp Assistant, which performs several tasks: 

• It enables you to burn a CD containing drivers you’ll need after you 
install Windows. 

• It divides your disk into two partitions, one of which will hold 
Windows. 

• It launches Windows Setup. 

To begin the process, follow these steps: 

1. Quit all applications. 

2. If any other users are logged in at the moment, switch to each 
account in turn and log out. 

3. Double-click the Boot Camp Assistant application located in 
/Applications/Utilities. A notice appears reminding you 
that this is preview software and that you shouldn’t trust any 
critical data to it. Read this and click OK. 

4. In the Introduction window, read the explanation of what Boot 
Camp Assistant does, and click Continue. 

5. In the next window (Figure 2), with Burn a Macintosh Drivers CD 
Now selected, click Continue. 
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Figure 2 
 

 

 Boot Camp Assistant offers to burn a CD containing crucial drivers. 

  6. Insert the blank recordable CD (or DVD) you set aside earlier and 
click Burn. When the CD is ready, Boot Camp Assistant ejects it 
automatically. Label the CD and keep it handy; you’ll need it in 
about an hour. 

7. In the next window (Figure 3), you tell Boot Camp how much 
space to set aside for the Windows partition. You can either stick 
with the default size of 5 GB or drag the divider left or right to 
change the amount. The minimum size is 5 GB and the maximum 
is 5 GB less than the amount of free space currently on your disk. 
(For more guidance on choosing a partition size, see the sidebar 
Partition Sizes just ahead.) Click Partition. 
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Figure 3 
 

 

 Drag the divider between the two partitions to determine how much 
disk space Boot Camp allots to Windows. 

  
 

PARTITION SIZES 

How large should your Windows partition be? The answer de-
pends primarily on how much Windows software you intend to 
install, because this partition must hold all your Windows pro-
grams. If you already know what software you’ll be using, consult 
the system requirements for each application and add up how 
much space they need; add at least 1.5 GB for Windows itself. Also 
consider how much space you’ll want for documents you save in 
Windows (including media, such as photos and music files), and 
include that in your total as well. (If you’re still unsure, I suggest 
from 6 to 10 GB; with the default setting of 5 GB, you may not 
have enough space for common tasks such as burning CDs.) 

Be aware that although you may be able to access your Windows 
files while running Mac OS X (see Access Windows Files from Mac 
OS X), the reverse is not true; Boot Camp does not let you access 
files on your Mac partition while running Windows. (Some work-
arounds exist, though; see Access Mac OS X Files from Windows.) 
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8. The final window in Boot Camp Assistant (Figure 4) is labeled 
Start Windows XP Installation. When you get to this window, 
insert your Windows installer CD and click Start Installation. Your 
Mac restarts from the Windows CD, and Windows Setup runs. 

Figure 4 
 

 

 Click Start Installation to restart your Mac and run Windows Setup. 

  Read on for more details about the Windows installation process. 

Install Windows XP 
If you’ve ever installed Windows before, you’ll find the setup program 
to be the same as on any other PC. Most of the options are self-
explanatory. However, a few steps in the Windows installation 
process require some explanation. Follow these steps: 

1. After restarting from the Windows CD and waiting for few minutes 
while it goes through some preliminary steps, you’ll see a screen 
like that shown in Figure 5. Press Return to begin the installation 
process. 
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NOTE RETURN VS. ENTER 

Mac and Windows keyboards differ in how they label the “car-
riage return” key—the key you press to confirm something or 
(like returning a typewriter’s carriage to its starting position) to 
move to a new line. If you’re using a Mac keyboard, this key is 
labeled Return. There may also be a key on the numeric keypad 
labeled Enter; Mac OS X considers these two different keys. On 
a Windows keyboard, however, the carriage return key is labeled 
Enter, and the Enter key on the numeric keypad performs the 
same function. 

When Windows (or Windows Setup) asks you to press the Enter 
key, you must press the Return key—not the Enter key—if you’re 
using a Mac keyboard; the Enter key will typically do nothing. If, 
however, you have a Windows keyboard attached, you should 
press the Enter key as instructed. 

   

Figure 5 
 

 

 The slick, colorful, and modern interface of Windows Setup walks 
you through the process in plain (text) English. 
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2. To agree to the End User License Agreement, press F8. 

3. On the next screen (Figure 6), the installer asks you to choose 
which partition to install Windows onto. Using the arrow keys to 
move up or down, highlight drive C: and press Return. 

Warning! Choosing anything other than C: on this screen may 
erase all or part of your Mac OS X partition. Also, resist the 
temptation to delete that mysterious E: partition, which is 
necessary for proper operation of your computer. 

 

Figure 6 
 

 

 When installing Windows under Boot Camp, choose the C: partition. 
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4. Next, the installer asks you to choose which file system to use 
when formatting the Windows partition (Figure 7). Your choices 
are NTFS or FAT, and for each one you can choose either a stan-
dard or “Quick” option. In most cases, the option I recommend 
is Format the partition using the FAT file system 
(Quick), partly because you can easily convert from FAT to 
NTFS—but not the other way around—later on. But read the 
sidebar just ahead, Choosing a File System, for more information. 
After making your selection, press Return; on the confirmation 
screen that appears next, press Return again. 

Figure 7 
 

 

 Choose a file system on this screen. FAT (Quick) is a good initial 
choice for most users; you can convert it to NTFS later. 

  5. The Windows installer formats the partition and then spends 
several minutes (or more) copying files from the CD to the hard 
disk. When it’s finished copying, your computer restarts again 
from the hard disk to complete the setup process. 
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CHOOSING A FILE SYSTEM 

A file system is simply a method for storing data on disk. Mac 
OS X normally uses a file system called HFS+ (also known as Mac 
OS Extended), and Windows normally uses either NTFS or FAT 
(which comes in several varieties, including FAT16 and FAT32; 
Boot Camp uses FAT32, but don’t worry about that distinction). 

Apple’s Boot Camp documentation says that NTFS “provides 
better reliability and security,” while FAT “provides better 
compatibility” and enables you to read and write files on the 
Windows partition when running Mac OS X. Which is better? 

FAT (File Allocation Table) is an older standard. NTFS (NT—as in 
Windows NT—File System) is more modern, and includes support 
for journaling, security features such as encryption and access 
control lists (which can help to protect Windows from viruses), 
and file-level compression. (Many users don’t take advantage of all 
those features, but they’re available.) For stand-alone Windows 
machines, NTFS is almost always the most logical choice. 

However, since you’re installing Windows on a machine that also 
runs Mac OS X, FAT may be a better option. Mac OS X can mount 
a FAT partition and provide read and write access to files on that 
volume, whereas with NTFS, Mac OS X can read but not write 
files, making file sharing more awkward. Also, although you can 
easily convert a volume from FAT to NTFS, you can’t convert from 
NTFS to FAT without erasing the volume. So if in doubt, FAT gives 
you more initial flexibility. One limitation is that although FAT 
volumes can be larger than 32 GB, the Windows installer supports 
formatting FAT drives up to only 32 GB. So if you need a larger 
Windows partition on your Mac, NTFS is your only choice. 

What about the “Quick” option? As the name suggests, it’s faster 
than the standard method. The standard method checks the vol-
ume for bad sectors during formatting and can eliminate certain 
kinds problems caused by disk errors; the Quick option skips that 
check. New Boot Camp partitions should be error-free already, 
so save a bit of time and go with the Quick option. 

For more information about the differences between FAT and 
NTFS (and instructions on upgrading from FAT to NTFS), see 
http://www.microsoft.com/windowsxp/using/setup/expert/russel
_october01.mspx. 

http://www.microsoft.com/windowsxp/using/setup/expert/russel_october01.mspx
http://www.microsoft.com/windowsxp/using/setup/expert/russel_october01.mspx
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6. The final phase of Windows installation is generally lengthy; 
depending on the speed of your computer and hard drive, you may 
have to wait an hour or more for it to finish (see Figure 8). 

Figure 8 

 

 

 If you have nothing to do for the next 39 minutes (give or take), sit 
and read all these marketing blurbs. Or just go for a jog. 

  7. In the course of installation, you’ll have to enter information on 
several screens (including the password you want to use, your time 
zone, and which sort of network you have). Most of these questions 
are self-explanatory (and similar to questions you answered when 
installing Mac OS X). As always, choose a good password that isn’t 
found in a dictionary and would be difficult to guess. One setting 
that may be confusing if you’re not a regular Windows user is the 
Workgroup or Computer Domain (see Figure 9). If you’re using 
Windows on just one computer in your home or office, the default 
choice (No, with workgroup name WORKGROUP for Windows XP 
Professional or MSHOME for Windows XP Home) is fine. If you’re 
connected to a network with other Windows computers, ask your 
system administrator what to enter here. And don’t worry, you can 
always change this later if you enter the wrong thing now. 
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Figure 9 
 

 

 If you’re installing Windows on a stand-alone computer, stick with 
the first option, and don’t worry about which workgroup you enter 
here. 

  8. When the installation is finished, your computer restarts. Ignore 
the message informing you that you can press any key to start from 
the CD, and it will disappear after a few seconds. 

Warning! I really mean it: Ignore that message! Do not press 
any key! If you do, you’ll get into a loop of attempting to start 
from a CD, when what you want to do at this point is start from 
the hard disk. 

9. Depending on your display, you may see a message stating that 
Windows will automatically adjust your screen resolution. Click 
OK, and then click OK again to confirm the change (you can 
change the resolution settings again later). 

10. Windows asks a couple more setup questions, such as whether to 
turn on Automatic Updates (I suggest yes) and a request for your 
name. Work your way through these, and you’re done. 
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When the setup is finished, the Windows Desktop and Start menu 
appear, and you’re off and running. But before you get carried away, 
be sure to follow the instructions in the next section for installing 
Macintosh drivers. 

Take note: At this point in the process, your screen resolution 
may still be wrong; you may have a fairly small image stretched 
unnaturally to fit your larger display. Don’t worry about this; when 
you install the Macintosh drivers, next, this problem will go away. 

Install Mac Drivers for Windows 
A driver is a piece of software that tells an operating system how to 
communicate with some sort of hardware. Every part of your com-
puter, and every peripheral, has a driver; that includes your video 
card, hard drive, keyboard, mouse, printer, audio interface, and many 
other components. Windows, like Mac OS X, includes built-in drivers 
for a wide range of common devices. 

However, a basic installation of Windows does not contain drivers 
for some components of your Mac, which means that those devices 
may work only partially or not at all. The Macintosh Drivers CD you 
burned earlier adds these drivers to Windows, so that while running 
Windows you can use your Mac’s built-in graphics card, Ethernet and 
AirPort networking, audio input and output, the brightness controls 
on iMacs and notebooks, the Eject key on your keyboard, and (some) 
Bluetooth peripherals. 

To install the Mac drivers, follow these steps: 

1. If the Windows XP CD is still in your computer’s optical drive, 
eject it. Since you haven’t yet installed the driver for the Eject key 
on your keyboard, you have to do this the old-fashioned way: 

a. Choose Start > My Computer. 

b. Click the icon for the CD/DVD Drive (D:) once to select it. 

c. Choose File > Eject. 

2. Insert your Macintosh Drivers CD. The installer runs 
automatically. 

3. Select your language and click OK. 
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4. When the Welcome screen appears, click Next. 

5. Click Yes to agree with the license agreement. 

6. As the installer runs, numerous windows may appear and disap-
pear. Don’t touch anything (and especially don’t click the Cancel 
button!), even if there appear to be delays lasting several seconds 
or more; let the process continue until the InstallShield Wizard 
Complete window appears. Then, with Yes, I Want to Restart 
My Computer Now selected, click Finish. Windows restarts. 

Take note: Depending on which Mac model you have, during 
the installation process you may see warnings that some soft-
ware has not passed Windows Logo Testing. Since Boot Camp is 
still beta software, that’s to be expected, and it’s nothing to worry 
about. (In fact, even in final software releases, some companies 
opt not to perform Windows Logo Testing because it’s an expen-
sive and time-consuming process.) If you see such a message, 
click Continue Anyway. 

7. After the restart, your screen resolution should automatically be 
set correctly. You may (or may not) see the Windows Found New 
Hardware Wizard. If you do, follow the instructions to set up the 
newly discovered devices. 

Take note: Depending on your Mac model, you may see 
additional windows at this point. 

If you see an ATI Registration dialog box, select Never Remind 
Me Again and click Continue (since you don’t need to register 
your computer’s video card separately). 

If you see a DeskTop Help window with the text “Using TV 
Display” in it, uncheck the Show Window at Start Up when TV 
Display Is Enabled checkbox and click the close box in the upper-
right corner of the window. (Do not bother attempting to disable 
the TV display; that procedure likely won’t work on your Mac.) 

Solve Input Device Problems 
Under Boot Camp, the keyboard and mouse, trackpad, or trackball 
that function perfectly in Mac OS X may not work correctly in Win-
dows. Users of notebook computers and Bluetooth input devices have 
additional problems. But you can solve them with a few easy steps. 
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TIP If you customarily use the numeric keypad on your keyboard for 

entering numerals, remember that in Windows the keypad’s 
default setting is such that it functions as directional keys. To 
use it for entering numerals, you must first press the Clear key 
on the keypad, which functions as Num Lock. 

  
Right-click with a one-button mouse 
If you’re using a Mighty Mouse or a third-party mouse or trackball 
that has two or more buttons, you can skip this section. If you’re 
using a one-button Apple mouse, however, you may run into frustra-
tions, since many actions in Windows require right-clicking. In Mac 
OS X, you can press Control while clicking to display a contextual 
menu (the Mac equivalent of a Windows right-click menu), but this 
trick doesn’t work under Boot Camp. You can, however, install a free 
third-party tool to get the same behavior. Follow these steps: 

1. Go to http://www.geocities.com/pronto4u/applemouse.html and 
download the Apple Mouse Utility. 

2. Unzip the downloaded file. 

3. Double-click the applemou program, and click OK. 

Now, to emulate a right click, hold down Control while clicking. This 
feature lasts only until you restart the computer. To avoid having to 
relaunch the program every time you restart, follow these steps: 

1. Right-click (that is, Control-click) the Start button and choose 
Properties. 

2. Select Classic Start Menu and click Customize. 

3. Click Advanced. A window opens displaying a Programs folder. 

4. Double-click the Programs folder to open it. 

5. Move the applemou program (or a shortcut to it) into the Startup 
folder in this window. To create a shortcut (similar to an alias in 
Mac OS X, right-click (or Control-click) and drag the icon to its 
destination; when you release the mouse button, choose Create 
Shortcuts Here. 

The applemou program loads each time you log on. 

http://www.geocities.com/pronto4u/applemouse.html
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NOTE Not that it matters much, but in Mac OS X, you log in and log 

out, whereas in Windows, you log on and log off. I’ve tried to use 
the preferred terminology in this ebook for whichever OS I’m 
discussing at the moment. 

  
Use Bluetooth input devices 
Curiously, although the Macintosh Drivers CD contains a driver for 
your Mac’s built-in Bluetooth transceiver, it does not support Apple 
Bluetooth keyboards and mice. However, all is not lost. To enable 
support, follow these steps: 

1. Download a small application prepared by Stephen Cattaneo: 
http://www.stephenjc.com/onmac/btinstall.zip. (Note that this 
application makes several registry changes, among other things; 
use at your own risk.) 

2. After unzipping the downloaded file, double-click the file 
install.cmd. 

3. Allow the Found New Hardware Wizard to connect to Windows 
Update and install the new software automatically. (You may have 
to do this more than once). 

4. Double-click the Bluetooth icon in the Windows notification area 
(in the lower-right corner of the screen). If the icon doesn’t appear 
there, choose Start > Control Panel; make sure you’re in Classic 
view (if not, click the Switch to Classic View link), and then double-
click the Bluetooth Devices icon. 

5. On the Devices tab, click Add. 

6. Select My Device Is Set Up and Ready to Be Found. 

7. For an Apple Wireless Mouse, turn it off, and then (holding 
it upside down) turn it back on again. For an Apple Wireless 
Keyboard, turn it off and back on. Then click Next. 

8. Select a Bluetooth device (mouse or keyboard) in the list and click 
Next. 

9. Select Don’t Use a Passkey and click Next. After the device is 
paired, click Finish. 

http://www.stephenjc.com/onmac/btinstall.zip
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Your Bluetooth input device should now work correctly; if necessary, 
repeat steps 5 through 9 with additional devices. 

  
NOTE Sometimes, after restarting under Boot Camp, Windows XP 

will not respond to your Bluetooth keyboard, even though the 
Bluetooth Devices control panel lists it as connected. If this hap-
pens to you, try turning the keyboard off and back on and wait-
ing about 10 seconds. If that doesn’t work, you may have to 
remove and re-add the keyboard in the Bluetooth Devices 
control panel. 

  
Press Control-Alt-Delete without a Delete key 
In Windows XP, the key combination Control-Alt-Delete is impor-
tant. In some configurations, it displays the logon prompt, without 
which you can’t log on! It also displays the Task Manger, which 
(among other things) enables you to quit stubborn programs, much 
like Mac OS X’s Force Quit feature (accessed via Command-Option-
Esc) does. If you’re using an Apple keyboard under Windows XP, the 
Option key functions as the Alt key, but Delete is more complicated. 
Most external keyboards have two Delete keys: one just to the right 
of the = key, which normally behaves as a backspace, and the other 
above the arrow keys, which sometimes has the symbol  and is 
technically a Forward Delete key (pressing it deletes the character 
to the right of the insertion point). Of these two, only the Forward 
Delete key works in conjunction with Control and Alt to display 
the Task Manager. 

This is no big deal if you’re using an external keyboard, but if you’re 
using the built-in keyboard on a Mac notebook, you have no separate 
Forward Delete key. To solve this problem, follow these steps: 

1. Download Microsoft’s rktools package from 
http://www.microsoft.com/downloads/details.aspx?FamilyID=9D
467A69-57FF-4AE7-96EE-B18C4790CFFD&displaylang=en. 

2. Run the rktools installer. 

3. Choose Start > Run. 

4. Type remapkey and click OK. The RemapKey window appears. 

http://www.microsoft.com/downloads/details.aspx?FamilyID=9D467A69-57FF-4AE7-96EE-B18C4790CFFD&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=9D467A69-57FF-4AE7-96EE-B18C4790CFFD&displaylang=en
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5. In the top keyboard diagram, find the Del (Forward Delete) key 
and drag it onto a key in the bottom keyboard diagram; the key 
you choose will function as Forward Delete. You could choose 
the  (Delete) key, although you’d lose the backspace function. 
Instead, consider mapping Del onto the Right Windows key 
two spaces to the right of the spacebar; this corresponds to the 
Command key on your keyboard immediately to the right of 
the spacebar. 

6. Click the Save and Exit button (leftmost on the toolbar). 

7. In the alert that appears, warning that you’ll lose the Right 
Windows key, click OK. Then click Yes to restart your computer. 

The right Command key now functions as Forward Delete and can be 
used to enter the Control-Alt-Delete sequence. 

Type special characters 
If you’re using an Apple keyboard (or a third-party keyboard designed 
for Macs), you’ll be unable to enter certain special characters, such as 
the euro (€) symbol. But you can work around this problem easily. 
Follow these steps: 

1. Choose Start > Control Panel. 

2. If “Pick a category” is displayed, click Date, Time, Language, and 
Regional Options and then click Regional and Language Options; 
otherwise, double-click Regional and Language Options. 

3. Click the Languages tab, and then click Details. 

4. Click the Add button. 

5. From the bottom drop-down menu, choose United States-
International and click OK. 

6. Click OK to close the Text Services and Input Languages window, 
and then click OK again to close the Regional and Language 
Options window. 

A keyboard icon ( ) appears in the notification area in the lower-
right corner of the screen. When you want to enter special characters, 
click this icon and choose United States-International from the pop-
up menu (see Figure 10). Then press the key combination or key 
sequence you need. For example, to type the € symbol, hold down the 
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right Option key and press 5; to type ñ, press right Option-N; to type 
é, type an apostrophe (') followed by an e. To return to your normal 
keyboard layout, choose English (United States) from the pop-up 
keyboard menu. You can find a complete list of special characters 
available in this keyboard layout and the shortcuts to enter them at 
http://support.microsoft.com/default.aspx?scid=kb;en-us;306560. 

Figure 10 

 

When you want to type special 
characters, choose United 
States-International from this 
pop-up menu in the notification 
area. 

   Take screen captures 
Mac users can take a snapshot of whatever’s on the screen at the 
moment and save it as a file by pressing Command-Shift-3. This trick 
doesn’t work when running Boot Camp, though, and if you have an 
Apple keyboard without a Print Screen (or Prt Scr) key, you’ll be 
unable to use the closest Windows equivalent. Pressing this key by 
itself normally places a copy of the frontmost window on the Clip-
board, from which you can paste it into a graphics program such as 
Paint to save it as a file; pressing it together with Alt (Option) cap-
tures the entire screen. Unfortunately, the remapkey program I 
described earlier doesn’t remap the Print Screen key. 

Never fear, though; you have several alternatives for performing this 
action under Boot Camp: 

• Use the On-Screen Keyboard: Choose Start > All Programs > 
Accessories > Accessibility > On-Screen Keyboard. In the keyboard 
that appears, click the psc button (to the right of F12) and click a 
window to put a copy of it on the Clipboard. To capture the entire 
screen, hold down Shift while clicking psc. But bear in mind that 
doing so captures the On-Screen Keyboard as well! 

• Use a third-party utility: Numerous excellent screen-capture 
programs exist for Windows, including SnagIt and MWSnap. 
http://www.techsmith.com/ ($40) 
http://www.mirekw.com/winfreeware/mwsnap.html (free) 

http://support.microsoft.com/default.aspx?scid=kb;en-us;306560
http://www.techsmith.com/
http://www.mirekw.com/winfreeware/mwsnap.html
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• Use Input Remapper: If you have a MacBook Pro, you can 
download and install a utility called Input Remapper that gives 
you a Print Screen capability as well as numerous other handy 
shortcuts. The only problem is that at present it works only with 
the MacBook Pro. 
http://www.olofsson.info/ (free) 

Switch between Mac OS X and Windows 
Under Mac OS X, you can switch from one startup disk to another 
by using the Startup Disk pane of System Preferences. The same pro-
cedure applies to switching from Mac OS X to Windows, and Apple 
even included with the Macintosh Drivers installation a version of 
the Startup Disk preference pane for Windows. 

To switch from Windows to Mac OS X: 

1. Choose Start > Control Panel. 

2. If the window says “Pick a category,” click Performance and 
Maintenance. 

3. Double-click the Startup Disk icon. 

4. Select your Mac OS X volume and click Restart. 

To switch from Mac OS X to Windows: 

1. Open System Preferences. 

2. Click the Startup Disk icon. 

3. Select your Windows volume and click Restart. 

Regardless of the volume you select using Startup Disk, you can also 
choose either operating system when you turn on or restart your com-
puter. To do so, hold down the Option key while restarting. Select the 
icon for the volume you want to use, and then click the arrow icon 
beneath it. 

Share Files across Platforms 
When you’re running Windows on your Mac, you may want access to 
files on the Macintosh partition; when you’re running Mac OS X, you 
may want access to files created under Windows. You can use any of 
several approaches to share files between the two platforms. 

http://www.olofsson.info/
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Access Windows files from Mac OS X 
When running Mac OS X, you can access files on your Windows 
partition simply by double-clicking the icon on your Desktop (or 
single-clicking the icon in the sidebar of a Finder window) that 
represents the Windows volume. (By default, this volume is called 
either NO NAME or Untitled; see the tip Rename Your Windows 
Volume, just ahead.) Your level of access to this volume depends on 
which partition format you chose. 

Hint: The first place to look on the Windows volume for files you 
created there is Documents and Settings/your-user-name.
Within that folder, look in the My Documents folder or the Desktop 
folder. 

If you formatted your Windows partition as a FAT volume, you can 
copy files to or from this volume just as you would with any other Mac 
volume; you can even open files using compatible Mac OS X applica-
tions without moving them at all. However, keep the following in 
mind: 

• Some Macintosh files store formatting, image previews, or other 
information in a portion of the file called the resource fork; these 
files may not appear correctly under Windows. 

• You can do serious damage by moving, deleting, or renaming any 
of the files that Windows needs to run. So stay away from anything 
outside the Documents and Settings folder—and within that folder, 
be sure you know what you’re doing before deleting or modifying 
anything. 

If you formatted your Windows partition as an NTFS volume, you 
can read files on the Windows partition or copy them to the Mac 
partition, but you cannot add new files to the Windows partition, 
nor can you modify or delete existing files. 

Take note: Even though you can see Windows files from within 
Mac OS X, you can’t run Windows programs without restarting into 
Windows. 



Page 46

TIP RENAME YOUR WINDOWS VOLUME

When you restart your computer in Mac OS X after installing
Windows, you’ll notice that your new Windows partition is named
either NO NAME (if you chose FAT) or Untitled (if you chose
NTFS); in Windows, it shows the default name Local Disk. You
can change this name to anything you like; the new name then
appears in both Windows and Mac OS X. To change the name
within Mac OS X (for FAT partitions only), click the disk’s name,
press Enter, and type a new name. To change the name within
Windows (FAT or NTFS), choose Start > My Computer, select the
disk, choose File > Rename, and type a new name. But be aware
that for FAT partitions, the disk name must be all uppercase.

Access Mac OS X files from Windows
Getting at files on your Macintosh partition while running Windows
is trickier; the Macintosh partition doesn’t appear when you’re run-
ning Windows, because Windows doesn’t understand the type of file
system Macs normally use. However, you can work around this
problem in any of the following ways.

Buy MacDrive
The easiest solution, by far, is to purchase Mediafour’s MacDrive
(http://www.mediafour.com/products/macdrive6/), a $50 applica-
tion that enables Windows to mount Mac volumes and read and write
files on them seamlessly, just as though they were Windows volumes.

Use an external drive
If you plug in an external USB or FireWire hard drive (or even one of
the many keychain-sized flash drives) and use Disk Utility to format it
as a FAT volume, both Mac OS X and Windows have full access to
files stored on it.

Use optical media
Within Mac OS X, you can burn a CD or DVD containing files you
want to use in Windows, and then copy the files from the optical disc
onto your Windows partition after restarting in Windows.

Use your iDisk
If you’re a .Mac member, you can mount your iDisk in both Mac OS X
and Windows and use it to store any files you want to access from
both platforms.

http://www.mediafour.com/products/macdrive6/
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Under Mac OS X, if you entered your .Mac user name and password 
on the Account tab of .Mac System Preferences, your iDisk should 
already appear in the sidebar of Finder windows. (If not, choose Go > 
iDisk > My iDisk, enter your information, and click Connect.) Click 
the iDisk icon in the sidebar to see the folders and files on it. I suggest 
putting shared files in the Documents folder. 

Under Windows XP, the easiest way to access your iDisk is to 
download and install the iDisk Utility for Windows from Apple 
(http://www.mac.com/1/learningcenter/Modules/dmStoringFiles_t3
.html). Run the application, enter your user name and password, and 
click Mount iDisk. 

Use a server 
If you have another computer (Mac or PC) on your local network, you 
can turn on Windows Sharing on that computer. Then, when running 
Mac OS X, mount that server’s volume and copy to it any files you 
want to use in Windows; when you restart in Windows, do the same 
thing to access the server’s files. 

To turn on Windows Sharing in Mac OS X so that a Mac can function 
as a server: 

1. Open the Sharing pane of System Preferences and go to the 
Services tab. 

2. Select the Windows Sharing checkbox. 

3. Click Accounts and select the checkbox for at least one account 
name. Click Done. 

4. Make a note (preferably on paper) of the address shown near the 
bottom of System Preferences, at which Windows users can access 
your computer. 

To mount a shared volume (such as the one you just set up) using 
another Mac: 

1. In the Finder, choose Go > Connect to Server. 

2. Click Browse. 

3. If the window is in Columns view, select the server and click 
Connect; if it’s in Icons or List view, double-click the server icon. 

http://www.mac.com/1/learningcenter/Modules/dmStoringFiles_t3.html
http://www.mac.com/1/learningcenter/Modules/dmStoringFiles_t3.html
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4. Enter your user name and password and click Connect. 

To mount a shared Mac volume in Windows: 

1. Choose Start > My Computer. 

2. Choose Tools > Map Network Drive. 

3. In the Folder field, enter the address you made a note of earlier (in 
Step 4 under “To turn on Windows Sharing in Mac OS X”). Click 
Finish. 

4. Enter the user name and password for the account and click OK. 

A window showing the shared items opens. In addition, a new icon 
representing the volume appears in the Network Drives section of the 
My Computer window. 

Get Rid of Your Windows Partition 
If at some point you decide you’ve had enough of Boot Camp (perhaps 
because you want to use virtualization software instead), you can 
remove the entire Windows partition from your disk. But don’t use 
Disk Utility to do this; use Boot Camp Assistant. To remove your 
Windows partition, follow these steps: 

1. Make sure you’ve backed up any information from the Windows 
partition that you want to keep, either by copying it onto the Mac 
partition while running Mac OS X or by putting it on a CD, DVD, 
external hard drive, or other media. 

2. Back up the Mac OS X partition of your drive. As I suggested when 
you set up Boot Camp initially, a complete, bootable duplicate onto 
an external hard drive is your safest bet. If something should go 
wrong during the repartitioning process, you could lose your 
valuable data, and a backup provides insurance. 

3. Launch Boot Camp Assistant (in /Applications/Utilities). 

4. In the first window that appears (Figure 11), select Restore the 
Startup Disk to a Single Volume and click Continue. 
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Figure 11 
 

 

 The bottom option on this screen lets you delete the Windows 
partition from your Mac. 

  5. Read the warning that your Windows XP volume will be com-
pletely erased, and then click Restore. Boot Camp Assistant 
prompts you for an Administrator password, and then removes 
the Windows partition and returns your disk to its original, single-
volume state. 

6. Click Restart. 

Your Mac is now back to having a single, Mac OS X volume. 
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INSTALL AND USE PARALLELS DESKTOP 

The second way of getting your Intel Mac to run Windows is to install 
virtualization software. You’ll get slightly slower performance and 
lose access to some hardware devices that you can use in Boot Camp, 
but in exchange you get the convenience of running Windows and 
Mac OS X at the same time. Switching between them is as easy as 
switching applications, because that’s exactly what you’re doing! 

In this section, I describe in detail the process of setting up and using 
Parallels Desktop, currently the best virtualization environment for 
Mac OS X by far. To learn about Q, skip ahead to Install and Use Q. 

  
NOTE If you’ve already installed Boot Camp, you may be wondering 

whether you can use that very same Windows installation 
under a virtualization environment. The answer is no—for now. 
Parallels says they’re looking into the possibility of adding that 
capability in the future. But even if they succeed, using Windows 
this way may violate the terms of your Windows End User 
License Agreement (particularly if you have a single-user retail 
license). 

There are no technical reasons why you can’t install Windows 
twice (or more) on the same machine—once in Boot Camp and 
once in Parallels, for example. But again, be sure to read your 
Windows license agreement carefully; it may require separate 
licenses for each instance of Windows. 

  
Parallels Desktop is easy to use, but a few steps you may have to take 
are not obvious. The basic process involves four main steps: install 
the Parallels Desktop application; set up a new virtual machine; 
install Windows in that virtual machine; and install the Parallels 
Tools within Windows. 

Important: Make sure you’ve set aside enough time for the entire 
process before starting. I recommend allowing at least 2 hours, of 
which one will be spent mostly waiting for Windows Setup to install 
all its files. However, also keep in mind that unlike with Boot Camp, 
you can continue using your Mac for other tasks while Windows is 
installing under Parallels Desktop. 
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Install Parallels Desktop
To install Parallels Desktop, follow these steps:

1. Download the software from http://www.parallels.com/en/
download/desktop/. You can purchase it for $50 (save $10 with
this coupon), or use it for 30 days as a free trial.

2. If you choose the free trial, you must also follow the link on the
download page to register and receive a trial activation key. (If you
purchased the software, you should have received an activation key
by email.) Without this key, the software will not run.

3. After mounting the downloaded disk image, double-click the
Parallels installer icon and follow the instructions to install the
software.

Parallels is now ready to run.

Set Up a New Virtual Machine in Parallels
Desktop
Each operating system you install requires its own virtual machine.
(You can, if you wish, install several different operating systems or
several instances of the same operating system.) To create a new
virtual machine for Windows XP, follow these steps:

1. Launch Parallels (in /Applications/Parallels). In the
Startup Options dialog (Figure 12), click New VM.

Figure 12 Parallels Desktop’s
Startup Options
window begins the
process of creating
a new virtual
machine.

http://www.parallels.com/en/download/desktop/
http://www.parallels.com/en/download/desktop/
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2. The New Virtual Machine Wizard (Figure 13) appears. Click Next.

Figure 13 The New Virtual
Machine Wizard
welcomes you.

3. On the next screen (Figure 14), with Create a Typical VM
selected, click Next.

Figure 14 You could try to
figure out a lot of
custom options
here, but the
default VM
settings work
well for most
users.
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4. On the Select Guest OS screen (Figure 15), with Windows chosen
as the default from the Guest OS Type pop-up menu, choose
Windows XP from the Guest OS Version pop-up menu. Click Next.

Figure 15 Choose your OS
type and version on
this screen.

5. On the Select Virtual Machine Configuration File screen
(Figure 16), I recommend that you keep the default settings.
However, if you wish, you can change the name of the virtual
machine or the location of the configuration file. Click Finish.

Figure 16 Keep the defaults
here, or choose a
different name and
location for your
virtual machine.

6. If an alert appears asking whether Parallels should automatically
create a new directory, click Yes. The Property Page View
(Figure 17) appears.



Page 54 

Figure 17 

 

 The Parallels Property Page View gives you an overview of the 
settings for a virtual machine. 

  7. If you haven’t already done so, activate Parallels Desktop using the 
code you obtained earlier. To do this: 

a. Choose Help > Activate Product. 

b. In the fields provided, enter the activation key, your name, and 
(optionally) your company name. 

c. Click Activate. When the thank-you message appears, click OK. 

Your virtual machine is now ready for installation of Windows. 

  
NOTE VIRTUAL DISKS 

When you set up a new virtual machine, Parallels also creates 
a special disk image file. When you run Windows, it will see this 
file as a separate disk. All your Windows files are installed in this 
virtual disk, but when you’re running Mac OS X you won’t see 
the individual files inside; it looks and acts like a single file. 

By default, Parallels gives the virtual disk an 8 GB capacity 
initially (although the disk image file itself starts out much 
smaller); it can grow as needed to accommodate more files 
(up to the amount of free space on your real disk). 
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BRIDGED VS. HOST-ONLY NETWORKING 

Parallels Desktop offers two networking modes, which affect how 
(if at all) Windows can communicate with other computers, both 
locally and over the Internet: 

• Bridged Ethernet: In Bridged mode (the default setting), the 
virtual machine appears as a separate computer on the network. 
This means that Windows will have its own IP address, separate 
from that of your Mac. If your network has a router or AirPort 
base station that uses DHCP to distribute IP addresses (as most 
do), this is generally the best and most convenient option, as 
it gives Windows direct access to the Internet. 

• Host-only networking: In Host-only mode, Parallels simu-
lates a network within your computer, meaning that Windows 
can use networking services to communicate with the Mac it’s 
running on but does not have direct access to the outside world, 
including the Internet. 

Depending on your network’s configuration and your individual 
needs, one of these modes may suit you better than the other. For 
example, if you’re using a virtual private network (VPN) or logging 
into a commercial wireless network while on the road, Bridged 
Ethernet may not play nicely with the host network. In such cases, 
you may be able to work around the problem by using Host-only 
networking, and then turning on Internet Sharing in Mac OS X’s 
Sharing Preference Pane so that Windows can see the Internet 
indirectly. However, since Parallels is still in development and 
the networking features are in a state of flux, I can’t yet offer you 
reliable advice on how to solve such problems. If Bridged Ethernet 
networking doesn’t work for you, look for advice in the Parallels 
forums at http://forums.parallels.com/. 

To switch between networking modes, click the Network Adapter 
link in the Property Page View. Then select either Bridged 
Ethernet or Host-Only Networking and click OK. 

Install Windows XP in Parallels Desktop 
To install Windows, follow these steps: 

1. Click the green triangle on the right side of the window to start the 
virtual machine. 

http://forums.parallels.com/
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Warning! If you have a Windows CD that includes Service 
Pack 2 (SP2), you can proceed with Step 2. But if your CD has an 
earlier version of Windows, which lacks some important built-in 
safeguards against viruses and other malware, your computer 
could be infected between the time you finish installing Windows 
and the time you install Service Pack 2 (yes, even if that’s only a 
few minutes!). Therefore, before you do anything else, follow 
these steps: 

a. Make sure you have a copy of SP2 handy, either on CD or as a 
downloaded file on your Mac. (To learn how to get a copy, see 
Prepare Your Computer, later in this ebook.) 

b. Disconnect your computer completely from the Internet. If 
you have a wired connection, unplug your Ethernet cable. If 
you use a wireless connection, choose Turn AirPort Off from 
the  menu. (Alternatively, if you know you won’t need 
Internet access at all in Windows, you can choose Host-Only 
networking; see the sidebar Bridged vs. Host-Only 
Networking on the previous page.) 

c. Proceed with the remaining steps in this section. Note that you 
will see several warnings to the effect that there is a problem 
with the network adapter. You can safely ignore these 
warnings. 

d. Run the SP2 installer. If you downloaded the file, the easiest 
way to do this is to move the file into your shared folder (see 
Share Files between Windows XP and Mac OS X, ahead) and 
then double-click it within Windows. 

e. After SP2 is installed and the virtual machine restarts, you can 
reconnect your Ethernet cable or turn AirPort back on. Then 
move on to Install Parallels Tools. 

2. If you’re using a Mac mini, you may encounter the error message 
shown in Figure 18. If you do, don’t panic; click OK, proceed with 
the rest of the installation, and then follow the steps in Correct the 
VT-x Error on a Mac mini. (You may have to dismiss this message 
multiple times unless you select the Do Not Show This Message 
Again checkbox.) If you don’t see this error message, smile and 
move on. 
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Figure 18 
 

 

 Don’t worry about this warning. Really. But if you can’t stop 
worrying, read on for a solution. 

  3. The screen shown in Figure 19 appears. Insert your Windows XP 
CD and wait 30 seconds or so while it spins up. Then click any-
where inside the black portion of the window and press the Return 
key on your keyboard. 

Figure 19 
 

 

 When this screen appears, insert your Windows CD and press Return. 
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4. Windows Setup runs. Press Return to begin the installation 
process. 

5. To agree to the End User License Agreement, press F8. 

6. On the next screen, the installer asks you to choose which file 
system to use when formatting the Windows partition (see 
Figure 20). Although I recommended using the FAT file sys-
tem in Boot Camp, within Parallels Desktop your best choice is 
probably Format the partition using the NTFS file 
system (Quick); it’s more secure, and FAT isn’t needed for file 
sharing. For more information about the file system options read 
the sidebar Choosing a File System, earlier. After making your 
selection, press Return. 

Figure 20 
 

 

 Pick a file system. Unlike in Boot Camp, NTFS (Quick) is generally 
the best choice here. 
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7. The installer asks which partition to use (Figure 21). Since you 
have only one option (“Unpartitioned space”), simply press 
Return. 

Figure 21 

 

 

 Press Return on this screen and move along. 

  8. The Windows installer formats the partition and then spends 
several minutes (or more) copying files from the CD to the hard 
disk. When it’s finished copying, the virtual machine restarts to 
complete the setup process. 

Take note: At this point in the installation process, you may see 
an alert that says “Unable to open device/file Default CD/DVD-
ROM.” If this happens, click OK. Press Control-Option to return 
control of the mouse to Mac OS X. Then choose Devices > 
CD/DVD-ROM 1 > Connect. 

9. The final phase of Windows installation is generally lengthy; 
depending on the speed of your computer and hard drive, you may 
have to wait an hour or more for it to finish. 

10. In the course of installation, you’ll have to enter information on 
several screens (including the password you want to use, your time 
zone, and which sort of network you have). Most of these questions 
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are self-explanatory (and similar to questions you answered when 
installing Mac OS X). As always, choose a good password that isn’t 
found in a dictionary and would be difficult to guess. One setting 
that may be confusing if you’re not a regular Windows user is the 
Workgroup or Computer Domain (Figure 22). If you’re using 
Windows on just one computer in your home or office, the default 
choice (No, with workgroup name WORKGROUP for Windows XP 
Professional or MSHOME for Windows XP Home) is fine. If you’re 
connected to a network with other Windows computers, ask your 
system administrator which domain (if any) to enter here. And 
don’t worry, you can always change this later if you enter the 
wrong thing now. 

Figure 22 

 

 

 Unless your system administrator tells you otherwise, go with the 
default setting here. 

  11. When the installation finishes, the virtual machine restarts again. 
Ignore the message informing you that you can press any key to 
start from the CD, and it will disappear after a few seconds. 
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12. You may see a message stating that Windows will automatically 
adjust your screen resolution. Click OK, and then click OK again to 
confirm the change (you can always change the resolution settings 
again later). 

13. Windows asks a few more setup questions, such as requests for 
your name and network settings. Work your way through these, 
and you’re done. 

When the setup is finished, the Windows Desktop and Start menu 
appear. But before you do anything else, be sure to follow the 
instructions in the next section for installing Parallels Tools. 

Important: In fact, before you even do that, if the copy of Windows 
you just installed doesn’t already contain Service Pack 2, apply the 
update to SP2. 

If you need to eject the Windows CD in order to insert an SP2 CD, 
choose Start > My Computer. Click the icon for the CD/DVD Drive 
(D:) once to select it, and then choose File > Eject. 

Install Parallels Tools 
When you first install Windows, you may notice a few annoying 
things. For example, mouse tracking will probably be slow and jerky, 
your options for video settings will be limited, and sound and network 
access may not work correctly. You can solve these and many other 
problems by installing Parallels Tools, a set of drivers that enables 
Windows XP to work better in its virtual environment. (As I noted 
in the Boot Camp section earlier, Parallels Tools are similar to Boot 
Camp’s Macintosh Drivers.) 

  
NOTE Before you install Parallels Tools, your mouse pointer must be 

under the control of either Mac OS X or Windows at any given 
time. As soon as you click anywhere within the virtual machine 
window, Windows “owns” your pointer, which means you can’t 
move it outside that window (as you’ll need to do to choose 
menu commands in Parallels). To return control of the mouse 
to Mac OS X, press Control-Option. Then, to hand control back 
to Windows, click inside the virtual machine window again. 

  



Page 62 

To install Parallels Tools, follow these steps: 

1. Make sure Windows XP is already running and that you’re logged 
in. (This will be the case if you’ve just installed Windows XP 
without changing any settings or logging out.) 

2. Press Control-Option to return control of the mouse to Mac OS X. 

3. Choose VM > Install Parallels Tools. Click OK when the alert 
message appears. 

4. Click once inside the virtual machine window to give control of the 
mouse back to Windows. When the Parallels Tools Setup Wizard 
appears, click Next. 

5. On the Setup Type screen, with the Complete option selected, click 
Next. 

6. Click your way through the rest of the installer, accepting all the 
default settings. When the installation is done, click Finish. 

The virtual machine restarts and the Parallels Tools become active. 
From now on, you can move the mouse smoothly into and out of the 
virtual machine window just as though it were any other window. 

  
TIP Before you begin installing additional Windows software and 

making other changes, consider backing up the disk image that 
holds your Windows XP virtual machine. That way, if anything 
goes seriously wrong with your Windows system in the future, 
you can return to this point—without having to go through all 
the tedious installation steps—simply by opening the backup disk 
image. To back up the disk image, make a copy of everything in 
~/Library/Parallels/ in another location, preferably on a 
different volume. 

  

Correct the VT-x Error on a Mac mini 
On some Mac mini models, you may encounter an error message 
about Intel Virtualization Technology (VT-x) being disabled. I’d like 
to take a moment to explain what this means, why you need not worry 
about it, and how to fix the problem if you’re worried anyway! 
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As you know by now, virtualization software such as Parallels Desktop 
does not need to emulate a different CPU in order to run Windows; it 
can feed most instructions straight through to (and from) the proces-
sor. However, newer Intel chips include technology called VT-x that 
optionally facilitates parts of the virtualization process that are ordi-
narily handled by software. If this feature is present on the CPU, 
enabled on the computer, and used by the virtualization software, the 
result is snappier performance in the virtual machine with less load 
on the CPU. So, while Parallels does not need VT-x, it can perform 
better with it than without. 

VT-x is built into all the CPUs that appear in Intel Macs and is en-
abled correctly on most of them. However, on some Mac mini models 
an incorrect firmware setting disables access to VT-x. (Apple consid-
ers this a bug, but it was not fixed in Firmware Update 1.0.1 for the 
Mac mini, released in April 2006.) It’s a tiny error: a matter of a 
certain variable being 0 when it should be 1. But it results in the 
annoying error message you see in Parallels. 

This error appears to exist only on certain Core Duo Mac mini mod-
els, though no clear pattern is apparent (such as a certain range of 
serial numbers or manufacturing dates). Furthermore, numerous 
users have found that the error message comes and goes—sometimes 
disappearing after waking the machine from sleep, and sometimes 
appearing and disappearing randomly. 

If you have such a machine, one valid approach is not to worry about 
it at all. Parallels Desktop, and Windows XP, will run acceptably 
without it. I’ve run benchmarking software on a Mac mini with VT-x 
enabled and disabled, and found the speed difference to be truly 
slight. So you could opt to select the Do Not Show This Message Again 
checkbox the next time you see the error message and be done with it. 

On the other hand, if that small difference in speed is important to 
you, or if you’re simply bothered by the notion that a useful capability 
in your processor is disabled for no apparent reason, you can change 
this firmware setting by performing a bit of black magic. It should 
enable VT-x support for good, give you a slight speed boost, and 
eliminate those error messages. 
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Warning! The procedure I describe here is potentially dangerous. 
If something goes wrong in the process, it could theoretically lead to 
damage that would require a trip to the repair shop—and that won’t 
be covered by Apple’s warranty. Although I believe the possibility 
of problems is vanishingly small, I feel obligated to point out that 
neither Apple nor I can assume any responsibility for problems this 
may cause; proceed at your own risk. Having said that, I should add 
that I performed this procedure on my own new Mac mini, and it 
worked perfectly well for me. 

To enable VT-x support on your Mac mini, follow these steps: 

1. Download this disk image: 
http://www.takecontrolbooks.com/resources/0034/rEFIt-with-
vmx.dmg. 

  
NOTE The disk image contains rEFIt (http://refit.sourceforge.net/), an 

open-source tool for modifying an Intel Mac’s EFI, and a pair of 
tiny programs, vmx-var-set.efi and vmx-var-reset.efi, writ-
ten by Joshua LeVasseur (http://i30www.ira.uka.de/~joshua/)— 
one to change this single setting, and the other to change it back. 

  
2. Open Disk Utility (in /Applications/Utilities). 

3. Choose Images > Burn, navigate to the disk image you downloaded 
in Step 1, and click Burn. 

4. Insert a blank, recordable CD and click Burn. Disk Utility burns 
the CD and ejects it when it’s finished. 

5. Reinsert this CD in your Mac mini, and choose Restart from the 
Apple menu. Immediately hold down the Option key, and keep 
holding it until you see the startup manager (Figure 23). 

http://www.takecontrolbooks.com/resources/0034/rEFIt-with-vmx.dmg
http://www.takecontrolbooks.com/resources/0034/rEFIt-with-vmx.dmg
http://refit.sourceforge.net/
http://i30www.ira.uka.de/~joshua/
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Figure 23 

 

The startup manager, as 
it appears on Intel Macs, 
enables you to choose a 
startup volume when you 
restart and hold down the 
Option key. In this case, 
click the rEFIt icon. 

   
 

  
NOTE The volumes you see here and on the following screens may 

vary depending on whether you have Boot Camp installed and 
whether your computer has any other bootable volumes (such 
as external hard disks) available. 

  
6. Click the rEFIt icon and then click the arrow icon beneath it. 

7. In the rEFIt menu that appears (Figure 24), immediately press 
the Down arrow key (possibly more than once) to select Start EFI 
Shell. Then press Return. 

Figure 24 
 

    

 After you choose rEFIt, you’ll see a screen similar to that shown 
on the left here, and you’ll have just 15 seconds to select the EFI 
Shell (as shown on the right) using the arrow keys. Do nothing in 
that time, and your Mac restarts from its hard disk as usual. 
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8. A command shell appears (similar to what you see in Terminal); 
wait a few seconds until the text stops flowing. Then, when the 
shell> prompt appears, type fs0: and press Return. (That last 
character is a zero.) 

Special note: Step 8 selects your optical drive, which usually 
has the designation fs0:. If that doesn’t work, try fs1: (and 
keep increasing the number at the end until it works). 

9. Type cd vmx and press Return. 

10. Type vmx-var-set.efi and press Return. 

11. Type exit and press Return. The rEFIt menu appears again. 

12. Do not choose the Boot Mac OS X option! Instead, press and hold 
down the power button on your computer until it turns off. Then 
unplug your computer. (If you’re using a MacBook or MacBook 
Pro, also remove the battery.) 

13. Wait 10 seconds. Then plug your computer back in (and replace 
the battery if necessary) and turn it on. 

VT-x support is now enabled. The next time you run Parallels, you 
should no longer see the error message. 

If at any point you want to return the VT-x setting to its original, 
disabled state, repeat Steps 5 through 13, but in Step 10 enter vmx-
var-reset.efi instead. 

Work with Windows XP in a Virtual Machine 
For the most part, Windows within a Parallels virtual machine just 
works; no special procedures are required. However, the following 
few tips could come in handy. 

Right-clicking 
If you have a Mighty Mouse or a third-party mouse or trackball with 
two or more buttons, the right button should work as a right click 
(producing a contextual menu) within Windows just as you’d expect. 
However, if you have a one-button Apple mouse, you can simulate 
a right click by holding down Control and Shift while clicking. 
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Special note: Beta versions of Parallels used the shortcut Control-
click (without the Shift key) for contextual menus because this is
analogous to the behavior of Control-clicking in Mac OS X; however,
this changed shortly before the final release, because Control-
clicking (without the Shift key) normally enables you to select
multiple noncontiguous items in Windows.

Using the optical drive
A CD or DVD in your computer’s optical drive cannot be used by both
Windows and Mac OS X at the same time. If a disc is mounted on the
Mac OS X Desktop, Windows can’t see it; if it’s mounted in Windows,
it disappears from the Mac Desktop. Sometimes you’ll find that a disc
is controlled by the wrong operating system.

If a disc is mounted on the Mac Desktop and you want Windows to
take over control of it, choose Devices > CD/DVD-ROM 1 > Connect.

If a disc is mounted in Windows and you want to relinquish control of
it to Mac OS X, choose Devices > CD/DVD-ROM 1 > Disconnect.

Adjusting screen resolution
To change the size of your Windows XP screen (and thus the size of
the window in Parallels in which it is displayed):

1. Choose Start > Control Panel.

2. If “Pick a category” is displayed, click Appearance and Themes and
then click Change the Screen Resolution. If not, double-click
Display and then click Settings.

3. Move the Screen Resolution slider left or right to the desired
setting. Click Apply.

4. A confirmation dialog box appears. If you like the new setting,
click Yes. If not, click No. If you don’t see the dialog box, your
screen’s resolution will revert automatically to its previous setting
in 15 seconds.
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Independent of screen resolution, you can switch between windowed
mode (the entire Windows environment is inside a window) and
full-screen mode (Windows takes up your entire display, just like
Mac OS X usually does). When you do this—assuming your screen
resolution was previously smaller than your physical display—
Parallels stretches the image to fit your display. Because that distorts
the image, you may want to adjust the screen resolution (following
the immediately preceding steps) to equal that of your display after
switching to full-screen mode.

To switch to full-screen mode, click the Fullscreen Mode button on
the right side of the Parallels window or choose View > Fullscreen.

To switch back from full-screen mode to windowed mode, press
Option-Return.

Shutting down, starting up, pausing, suspending, and
resuming
In Windows, as in Mac OS X, you should not turn off the computer
without telling the operating system to shut down; doing so prevents
Windows from properly closing files and performing certain cleanup
tasks. However, in lieu of shutting down, you can choose to suspend
Windows, saving its state (even if you quit Parallels Desktop) so that
you can return to exactly where you were in your next session
quickly—without waiting for Windows to boot. You can also (without
suspending Windows or quitting Parallels) pause the virtual machine,
which reduces the CPU usage of Parallels Desktop to a trickle—handy
if you momentarily need all your processor’s power for other tasks.

Table 1, on the next page, lists the procedures for controlling
Windows in Parallels Desktop.
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Table 1: Controlling Windows in Parallels Desktop 

To Do This… Follow These Steps… 

Shut down Windows 1. Choose Start > Turn Off Computer. 

2. Click Turn Off, and wait until the Parallels Property Page 
View reappears. (This may take up to a minute.) 

After shutting down, you may quit Parallels Desktop. 

Start up Windows Click the green triangle on the right side of the Parallels 
Property Page View or choose VM > Power On. 

Pause a virtual machine Choose VM > Pause. 

Resume a paused 
virtual machine 

Click the green triangle or choose VM > Continue. 

Suspend Windows Click the pause button or choose VM > Suspend. When the 
Parallels Property Page View reappears, you can quit 
Parallels Desktop. 

Resume Windows after 
suspending it 

Click the green triangle or choose VM > Power On, just as 
you would when starting Windows from scratch. 

  
Compacting the virtual disk 
As you use Windows, the virtual disk on which it stores its files may 
grow, but deleting files doesn’t automatically cause the image to 
shrink. To compact the virtual disk, follow these steps: 

1. Double-click the Parallels Tools Center icon ( ) in the notification 
area (the lower-right corner of the Windows portion of the window). 

2. In the list on the left, select Disk Compacting Tool. 

3. Make sure your virtual disk is selected in the list on the right (as it 
should be by default). 

4. Select the Execute All Stages at Once checkbox. 

5. Click Start; click Yes to confirm. 

6. A progress bar appears within Windows. After it fills, the virtual 
machine pauses and a second progress bar appears in Parallels 
Desktop. A message appears when the process is complete; click 
OK to return to Windows. 
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TIP For smaller virtual disks (and more flexible compression options), 

download a separate tool called Parallels VM Compressor. 
http://www.parallels.com/en/products/compressor/ 

  

Share Files between Windows XP and Mac OS X 
Although sharing files between Windows and Mac OS X under Boot 
Camp is sometimes challenging, under Parallels it’s easy. But again, 
you can use more than one approach. 

Use Parallels shared folders 
When you installed Parallels Tools, you added support to Windows 
XP for sharing folders with Mac OS X. (The Parallels shared folder 
feature is a breeze to set up, but you may find it to be slow; I cover 
another approach, Use Windows Sharing, ahead.) Before you can use 
this feature, you must turn it on and configure it: 

1. If the Windows XP virtual machine is currently running, choose 
Start > Turn Off Computer and click Turn Off. 

2. In the Parallels Property Page View (Figure 25), click Edit. 

Figure 25 
 

 

 In this window, you can see an overview of your virtual 
machine’s settings and change several aspects of its operation. 

  

http://www.parallels.com/en/products/compressor/
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3. In the Configuration Editor window, select Shared Folders in the 
list on the left (Figure 26). 

Figure 26 
 

 

 Click  to set up a new shared folder, which will be visible to 
both Windows and Mac OS X. 

  4. Make sure Enable Shared Folders is selected. 

5. Click the  button. The Shared Folder Properties dialog 
(Figure 27) appears. In this window, you can designate any 
Mac OS X folder to be shared with Windows. In this example, I use 
my Desktop folder, but you can choose another folder (or create a 
folder exclusively for this purpose). 
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Figure 27 
 

 

 Enter the path to your shared folder here, along with the name you 
want it to have in Windows. 

  6. In the Path field, enter the path to the folder (or, if you prefer, click 
Browse, locate the folder, and click Choose). 

7. In the Name field, enter a name for the shared folder; this is the 
name with which the folder will be labeled in Windows. Click OK. 

8. To designate other shared folders, repeat Steps 5 through 7. When 
you’re finished, click OK. 

9. Click the green triangle to restart the virtual machine. 

Your shared folders are now available. When Windows restarts, 
double-click the Parallels Shared Folders icon on your Windows 
Desktop to display a window containing all the shared folders you 
specified. You can drag files into and out of these folders just like 
any other folder. Likewise, any items you place in these folders while 
using Mac OS X immediately become available to Windows. 
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TIP With Parallels Tools installed, you can copy and paste text 

between Mac OS X and Windows. (Support for copying graphics 
is present but limited.) But if you use keyboard shortcuts, don’t 
forget that you have to switch from Command-C/X/V to Control-
C/X/V within Windows! 

  
Use Windows Sharing 
If the performance of Parallels shared folders seems too slow to you, 
you can try a different approach: turn on Windows Sharing under 
Mac OS X and then, in Windows, mount the shared volume. Even 
though you’re using just one computer, Windows will treat your Mac 
as though it were another computer on the network. 

To turn on Windows Sharing in Mac OS X: 

1. Open the Sharing pane of System Preferences and go to the 
Services tab. 

2. Select the Windows Sharing checkbox. 

3. Click Accounts and select the checkbox for at least one account 
name. Click Done. 

4. Make a note (preferably on paper) of the address shown in System 
Preferences at which Windows users can access your computer. 

To mount a shared Mac volume in Windows: 

1. Choose Start > My Computer. 

2. Choose Tools > Map Network Drive. 

3. In the Folder field, enter the address you made a note of earlier (in 
Step 4 under “To turn on Windows Sharing in Mac OS X” above).  
Click Finish. 

4. Enter the user name and password for the account and click OK. 

A window showing the shared volume opens. In addition, a new icon 
representing the volume appears in the Network Drives section of the 
My Computer window. 
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INSTALL AND USE Q 

The second virtualization package for Intel Macs, Q, is currently well 
behind Parallels Desktop in functionality and speed. But because it’s 
free and open-source, I’m sure some users will prefer it. In the next 
few pages, I want to offer a brief introduction to Q. In a future update 
of this ebook, after Q has matured somewhat, I may provide a more 
detailed exposition. 

As with Parallels, using Q involves four main steps: install the Q 
application; set up a new virtual machine; install Windows in that 
virtual machine; and install the Q drivers within Windows. 

Install Q 
To install Q, follow these steps: 

1. Download the software from http://www.kberg.ch/q/. You’ll find 
two links at the bottom of the page, one to the latest stable build 
and the other to the latest unstable build. Despite the slightly 
scary-sounding name, choose the unstable build, which will be 
more recent, and will likely have both more features and better 
speed, than the stable build. (If it doesn’t work well, you can 
always go back and fetch the stable build later.) 

2. After the download completes, the disk image should mount auto-
matically. If not, double-click the disk image file to mount it. 

3. Drag the Q application into your Applications folder. 

That’s it; installation is complete. 

Set Up a New Virtual Machine in Q 
Each operating system you install requires its own virtual machine. 
(You can, if you wish, install several different operating systems or 
several instances of the same operating system.) To create a new 
virtual machine for Windows XP, follow these steps: 

1. Launch Q (in /Applications). The Q Control window 
(Figure 28) appears. 

http://www.kberg.ch/q/
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Figure 28 

 

The Q Control window lists all the 
virtual machines you’ve created. 
When you launch Q for the first 
time, the window will be empty. 

   2. Click the + button to display the setup window for the new virtual 
machine (Figure 29). 

Figure 29 

 

Set basic options for a 
virtual machine here. One 
important change from 
the defaults: select the 
checkbox for the Q 
Windows drivers. 

   3. In the General pane, enter a name for the machine, such as 
Windows XP. Also select the Show Disk with Q Windows Drivers 
checkbox; leave the other options in this pane set as they are. 

4. In the Hardware pane (Figure 30), leave all the options set at 
their defaults except: 

a. For Sound Card, select Soundblaster 16. 

b. For Boot From, choose CD-ROM. 

5. Click Create PC. 

Q adds your new virtual machine to the Q Control list. 
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Figure 30 

 

Set the hardware config-
uration for your virtual 
machine here. Most impor-
tant: choose CD-ROM from 
the Boot From pop-up 
menu. 

   
Install Windows XP in Q 
To install Windows, follow these steps: 

1. Insert your Windows CD into your optical drive, and wait until it 
mounts on the Desktop. 

2. Select your new virtual machine in the Q Control list. 

3. Click the triangular Start PC button on the toolbar. 

Windows Setup runs. The process from here on is virtually the same 
as that for Parallels Desktop; refer to Install Windows XP in Parallels 
Desktop for instructions. But be aware that even the installation 
process is considerably slower than in Parallels. 

Important: When asked to choose which partition to use, be sure 
to choose “Unpartitioned space” and not C:, which contains the Q 
drivers. 
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Install Q Drivers 
Like Boot Camp and Parallels Desktop, Q includes its own drivers 
that greatly improve several features, especially video performance. 

To install the Q drivers, follow these steps: 

1. Choose Start > My Computer. 

2. Double-click the C: drive, which should be labeled QDRIVERS. 

3. Double-click the Q Driver Installer for Windows XP (which may 
have a name like Q_win_2kxp_drivers-1_0_1.exe). 

4. Follow the prompts to install the drivers; click Finish when the 
installation is complete. 

You’re now ready to use Windows XP. 

  
TIP Because video options are so limited prior to the installation of 

the Q drivers, your next likely step will be to change your video 
settings. See Adjusting screen resolution in Q, ahead. 

  

Work with Windows XP in a Q Virtual Machine 
While running Windows, be aware of some peculiarities of the Q 
virtual machine. 

Changing mouse control 
Even after installing the Q Drivers, your mouse pointer must be under 
the control of either Mac OS X or Windows at any given time. As soon 
as you click anywhere within the virtual machine window, Windows 
“owns” your pointer, which means you can’t move it outside that 
window. To return control of the mouse to Mac OS X, press Control-
Option. Then, to hand control back to Windows, click inside the 
virtual machine window again. 

Choosing a boot volume 
In Q, you must explicitly decide, before starting Windows, whether 
to boot it from the virtual disk (which it considers a hard drive) or the 
CD-ROM drive. If you choose a volume that doesn’t currently contain 
a valid Windows installation, the startup process can hang; you must 
then close the window without saving the PC, change the boot 
volume, and try again. 
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To change the boot volume: 

1. Shut down Windows if it’s running. 

2. Select the virtual machine in the Q Control list and click the Edit 
button on the toolbar. 

3. In the Hardware pane, choose the desired boot volume (Harddisk 
or CD-ROM) from the Boot From pop-up menu. 

Adjusting screen resolution in Q 
To change the size of your Windows XP screen (and thus the size of 
the window in Q in which it’s displayed): 

1. Choose Start > Control Panel. 

2. If “Pick a category” is displayed, click Appearance and Themes 
and then click Change the Screen Resolution. If not, double-click 
Display and then click Settings. 

3. Move the Screen Resolution slider left or right to the desired 
setting. Click Apply. 

4. A confirmation dialog box appears. If you like the new setting, 
click Yes. If not, click No. If you don’t see the dialog box, your 
screen’s resolution will revert automatically to its previous setting 
in 15 seconds. 

  
NOTE Even after you install the Q drivers, your video options will be 

fewer than with Parallels Desktop. For example, Q offers fewer 
screen resolution settings and no full-screen mode. 

  
Shutting down, starting up, pausing, suspending, and 
resuming 
In Windows, as in Mac OS X, you should not turn off the computer 
without telling the operating system to shut down; doing so prevents 
Windows from properly closing files and performing certain cleanup 
tasks. However, in lieu of shutting down, you can choose to suspend 
Windows, saving its state (even if you quit Q) so that you can return 
to exactly where you were in your next session quickly—without 
waiting for Windows to boot. 
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Table 2 lists the procedures for controlling Windows in Q. 

 
Table 2: Controlling Windows in Q 

To Do This… Follow These Steps… 

Shut down Windows 1. Choose Start > Turn Off Computer. 

2. Click Turn Off, and wait until the screen says “It is now 
safe to turn off your computer.” 

3. Close the window. An alert appears saying the Guest 
PC is still running; click Don’t Save PC. 

After shutting down, you can quit Q if you wish. 

Start up Windows Select the virtual machine in the Q Control list and click 
the triangular Start PC button on the toolbar. 

Suspend Windows 1. Press Control-Option to release mouse control to 
Mac OS X. 

2. Click the close button of the virtual machine’s window. 

3. Click Save PC. 

Resume Windows after 
suspending it 

Select the virtual machine in the Q Control list and click 
the triangular Start PC button on the toolbar, just as 
when starting up Windows normally. 

    

Warning! The current unstable build as of the time I wrote this 
(0.8.0d1105) was truly unstable when it came to restoring a sus-
pended virtual machine: Windows crashed every time. This may 
have been fixed by the time you read this, but be sure to save any 
important work before suspending Windows when running Q. 

Share files between Windows XP and Mac OS X 
in Q 
When you run Q, it creates a new folder on your Mac OS X Desktop 
called Q Shared Files. To access this folder from within Windows, 
simply double-click the Q HD shortcut icon on your Windows 
Desktop. (Feel free to move this icon to another location if you 
prefer.) You can read and write files in this folder exactly as if it were 
any other Windows folder. Alternatively, you can share files using 
Windows Sharing as you can in Parallels; see Use Windows Sharing. 
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CREATE A SLIPSTREAM INSTALLER DISC 

I had an old, unused retail copy of Windows XP in my closet, and 
figured I’d finally put it to use by installing it under Boot Camp. But 
when I looked at the CD, I saw that it was an early release of Windows 
XP from 2001—before SP2 and even before SP1. Boot Camp requires 
a Windows CD with SP2 already on it; you can’t simply install an 
earlier version and then apply updates later. But I didn’t want to 
repurchase something I already had. 

By searching the Web, I found numerous instructions for creating 
what’s called a slipstream installer—one in which the components 
of SP2 (or other updates) have been merged with the original installer 
in such a way that the result is indistinguishable from a direct-from-
Microsoft Windows XP-plus-SP2 CD. Unfortunately, to create an SP2 
slipstream installer, you have to be running Windows already, and I 
had no Windows machines at my disposal. 

My solution was to install Parallels Desktop first, install Windows XP 
under Parallels, and then use that Windows installation to prepare 
the SP2 slipstream installer disc that I could later use with Boot 
Camp. 

  
NOTE Some Windows licenses expressly disallow installation both as a 

primary OS and within a virtual machine on the same computer, 
counterintuitive as that may sound (since it’s the same hardware 
and you can’t use both installations at once). Be sure to verify 
that you’re operating within the limits of your license. In addi-
tion, when you try to activate Windows on the second installation 
on a given machine with a given Product Key (whether within 
Microsoft’s licensing terms or not), you may encounter an error 
message prompting you to call Microsoft for assistance. 

  
Whether you find yourself in my situation or simply want to save 
yourself time later on, should you ever have to reinstall Windows (not 
a bad idea!), you can easily create a slipstream CD on any Windows 
computer with a CD/DVD burner, or on a Mac that’s already running 
Windows (by way of Parallels Desktop or otherwise). 
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Before we get to the instructions, I should mention that you can find 
dozens of different methods on the Web for creating slipstream 
installers. This is just one of many, but I like it because it’s easy, 
flexible, and fast, and it produced good results for me. 

Prepare Your Computer 
As always, you must assemble certain ingredients and configure your 
computer properly before getting down to business. Follow these 
steps: 

1. Boot into Windows XP. This can be a copy running on a PC, via 
Boot Camp, or in a Parallels Desktop or Q virtual machine. The 
copy of Windows you use for creating a slipstream CD does not 
have to include Service Pack 2. 

2. Obtain a copy of Service Pack 2. You can do this in either of two 
ways: 

a. Download it from http://www.microsoft.com/downloads/ 
details.aspx?FamilyId=049C9DBE-3B8E-4F30-8245-
9E368D3CDB5A&displaylang=en. However, note that this is a 
266 MB download; if you don’t have a very high-speed Internet 
connection, that will take a while.  

b. Alternatively, order it on CD from Microsoft, using this page: 
http://www.microsoft.com/windowsxp/downloads/updates/ 
sp2/cdorder/en_us/default.mspx. The software itself is free but 
Microsoft charges you for shipping and handling: this CD will 
set you back a whopping $1.65 (plus tax!). Microsoft claims that 
your CD requires 4 to 6 weeks for shipping, but my copy arrived 
4 days after I ordered it. 

3. Copy the contents of your (older) Windows CD onto your hard 
disk. To do this: 

a. Insert the Windows CD into your optical drive. A window will 
probably appear automatically; close it. 

b. Right-click (or Control-click) on the Desktop, choose 
New > Folder, and enter a name for the folder (such as 
XP_Installation). 

c. Choose Start > My Computer. Right-click (or Control-click) 
the icon for the Windows CD and choose Explore. 

http://www.microsoft.com/downloads/details.aspx?FamilyId=049C9DBE-3B8E-4F30-8245-9E368D3CDB5A&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyId=049C9DBE-3B8E-4F30-8245-9E368D3CDB5A&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyId=049C9DBE-3B8E-4F30-8245-9E368D3CDB5A&displaylang=en
http://www.microsoft.com/windowsxp/downloads/updates/sp2/cdorder/en_us/default.mspx
http://www.microsoft.com/windowsxp/downloads/updates/sp2/cdorder/en_us/default.mspx
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d. Select all the files and folders on the CD and drag them into 
your XP_Installation folder. 

e. Leave the Windows CD in your drive for now; the installer you 
run in the next step may need to copy some files from it. 

4. If you haven’t already done so (or aren’t sure), install the Microsoft 
.NET framework. To do this: 

a. In Internet Explorer (or the browser of your choice), go to 
http://www.microsoft.com/downloads/details.aspx?FamilyID=
0856eacb-4362-4b0d-8edd-aab15c5e04f5&DisplayLang=en 
and click the Download button. 

b. Click Save when asked what you want to do with the file and 
select your Desktop as the destination. 

c. When the download is complete, double-click the file 
dotnetfx.exe on your Desktop; if a Security Warning dialog 
box appears, click Run. 

d. Follow the prompts to install the .NET framework. When 
installation is done, click Finish. 

Your computer is now ready for the slipstreaming process. 

Run nLite 
Although you can create a slipstream installer using nothing more 
than the Windows command prompt, a free helper application called 
nLite makes the process easier. Follow these steps: 

1. Download and install nLite: 

a. Download nLite from http://www.nliteos.com/download.html. 

b. Click Save when asked what you want to do with the file and 
select your Desktop as the destination. 

c. When the download is complete, double-click the nLite 
file on your Desktop (which may have a name like 
nlite1.0rc7i.exe); if a Security Warning dialog box 
appears, click Run. 

http://www.microsoft.com/downloads/details.aspx?FamilyID=0856eacb-4362-4b0d-8edd-aab15c5e04f5&DisplayLang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=0856eacb-4362-4b0d-8edd-aab15c5e04f5&DisplayLang=en
http://www.nliteos.com/download.html
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d. Follow the prompts to install the nLite application. (You can 
accept all the default settings in the installer.) When installation 
is done, make sure the Launch nLite checkbox is selected and 
click Finish. 

2. The nLite application opens (Figure 31). Click Next. 

Figure 31 

 

 The opening window of nLite, a slipstream helper application. 
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3. In the next window (Figure 32), click Browse. Select the 
XP_Installation folder on your Desktop and click OK. Click 
Next. 

Figure 32 

 

Click Browse and 
navigate to the 
folder into which 
you copied the 
contents of your 
Windows CD. 

   4. In the nLite Presets window (Figure 33), click Next. 

Figure 33 

 

You can safely 
ignore this 
window. 
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5. In the Task Selection window (Figure 34), click Integrate a 
Service Pack and Create a Bootable ISO to select those two options. 
Then click Next. 

Figure 34 

 

 

 For a basic slipstream installer, select just the top and bottom 
options here. The other options give you more control over your 
Windows installation and are more appropriate for advanced users. 

  
 

  
NOTE The nLite software offers a wide range of options I don’t cover 

here. For example, it can integrate not only service packs but 
also other updates and patches. In addition, it can build into 
your installer settings such as your Product Key (to enable 
unattended installation) and can preconfigure a wide variety of 
Windows settings to save you time after the installation is 
finished. All these can greatly reduce the hassle of reinstalling 
Windows, should you ever need to do so. Consult the nLite 
documentation for details on these extra features. 
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6. In the next window (Figure 35), click Select. Locate your Win-
dows XP Service Pack 2 file, in either of these ways: 

• If you downloaded SP2, navigate to the file named XPSP2.exe 
and select it. 

• Or, if you have SP2 on a CD, click My Computer. Right-click (or 
Control-click) the CD-ROM icon and choose Eject to eject your 
Windows CD. Insert the SP2 CD. When it appears in the win-
dow, double-click it and select the XPSP2 icon. 

Then click Open. 

Figure 35 

 

 

 Click Select to locate the CD or downloaded file containing Service 
Pack 2. 

  7. nLite immediately begins creating the slipstream installer. When 
the process is finished, click OK. Then click Next. 

8. Your final task in nLite is to create a disk image for the installer, 
from which you can later burn a CD. To do this, fill in a name for 
the CD (such as WinXP-SP2—or stick with the default, WinLite) 
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and click Make ISO (see Figure 36). Select a destination (your 
Desktop is a good idea) and click Save. When the image is 
complete, click Next and then Finish. 

Figure 36 

 

 

 Enter a name for your slipstream disc image and click Make ISO. 

  
Burn a Windows XP+SP2 CD 
Last but not least, burn a CD from the disk image you created in the 
previous section. You can go about this in any of several ways. 

If you created the image using Parallels Desktop or Q: 

1. Copy or move the file into your shared folder, so that you can 
access it from Mac OS X. (Both Parallels Desktop and Q place a 
shortcut to your shared folder on the Desktop, assuming you’ve 
configured them correctly; see Share Files between Windows XP 
and Mac OS X or Share Files between Windows XP and Mac OS X 
in Q.) 

2. In Mac OS X, open Disk Utility (in /Applications/Utilities). 
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3. Choose Images > Burn. 

4. Navigate to the disk image file, select it, and click Burn. 

5. Insert a blank recordable CD into your optical drive and click 
Burn. 

Disk Utility automatically ejects the disc when it’s ready; you can then 
quit Disk Utility. 

If you created the image on a PC or using Boot Camp: 

Windows includes built-in CD-burning capabilities, but unfortu-
nately, this does not include bootable CDs. Therefore, you’ll have 
to use third-party software. If you have a commercial tool such as 
Roxio’s Easy Media Creator (http://www.roxio.com/en/products/ 
emc/family.jhtml; editions ranging from $50 to $100) or Nero 
(http://ww2.nero.com/nero7/enu/Products.html; $80), you can 
certainly use that. However, you can also achieve acceptable results 
using a small program called burnatonce that’s free for noncommer-
cial use. 

To burn a CD with burnatonce, follow these steps: 

1. Download burnatonce from http://www.afterdawn.com/software/ 
cdr_software/cdr_applications/burnatonce.cfm. 

2. Click Save when asked what you want to do with the file, and select 
your Desktop as the destination. 

3. When the download is complete, double-click the burnatonce file 
on your Desktop (which may have a name like bao0995.exe); if a 
Security Warning dialog box appears, click Run. 

4. Follow the prompts to install the burnatonce application. (You can 
choose all the default settings in the installer.) When installation is 
done, make sure the Launch burnatonce checkbox is selected and 
click Finish. 

http://www.roxio.com/en/products/emc/family.jhtml
http://www.roxio.com/en/products/emc/family.jhtml
http://ww2.nero.com/nero7/enu/Products.html
http://www.afterdawn.com/software/cdr_software/cdr_applications/burnatonce.cfm
http://www.afterdawn.com/software/cdr_software/cdr_applications/burnatonce.cfm
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5. In the burnatonce window (Figure 37), choose File > Load New 
Image. Navigate to the disk image file, select it, and click Open. 

Figure 37 
 

 

 This simple utility enables you to burn a .iso disk image as a 
bootable CD. 

  6. Insert a blank recordable CD into your optical drive. When the 
window shown in Figure 38 appears, select Take No Action and 
click OK. 

Figure 38 

 

If this alert appears, select 
Take No Action, click OK, 
and keep going. 

   7. Back in the burnatonce window, click Write. Click OK to confirm 
that you want to burn the CD. 

When burnatonce finishes burning the CD, it ejects the disc 
automatically. 
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PROTECT YOUR WINDOWS SETUP FROM MALWARE 

As a Mac user, you’ve probably never lost any sleep over viruses, 
Trojan horses, worms, spyware, adware, and all the other nasty stuff 
known collectively as malware (that is, malicious software). Such 
programs are few and far between on Mac OS X, but they’re a gigantic 
problem on Windows. Now that you’re running Windows on your 
Mac, you have to worry about malware too, especially since a program 
could conceivably cause damage not only to your Windows partition 
(or virtual disk) but also to your Mac files. You can learn more about 
malware in the Wikipedia: http://en.wikipedia.org/wiki/Malware. 

  
NOTE Much of this section was inspired by Kevin van Haren’s article 

“Windows Tips and Tricks for Mac Users” in TidBITS: 
http://db.tidbits.com/getbits.acgi?tbart=08502. The full article 
contains numerous other suggestions, including a list of utility 
software you may find handy for duplicating certain features 
built into Mac OS X. 

  
Preventing attacks by malware (and repairing the damage they’ve 
caused) is a large and complex subject that could easily fill several 
large books. In this section, I want to outline just the basics, acquaint-
ing you with some of the most important steps you should take to 
protect your computer and a few good tools to help you. 

  
TIP If you already have malware on your computer and you can’t 

figure out how to remove it, one easy step to try is using 
Microsoft’s Malicious Software Removal Tool, available free from 
http://go.microsoft.com/fwlink/?LinkId=40587. This program, 
which is updated monthly, does not prevent malware from being 
installed on your computer, but it can undo many types of 
damage. 

  

Apply Windows Updates 
Beyond Service Pack 2 are numerous smaller updates from Microsoft 
that fix bugs, plug security holes, and make your computer more 
resistant to malware. You should install these as soon as possible 
after installing Windows (and configure Windows to download and 
install new updates automatically as they appear). 

http://en.wikipedia.org/wiki/Malware
http://db.tidbits.com/getbits.acgi?tbart=08502
http://go.microsoft.com/fwlink/?LinkId=40587
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Previously, the recommended way to install updates was to visit 
Microsoft’s Windows Update site (http://update.microsoft.com/). 
You can still do that, but Microsoft now offers an easier way to keep 
your system current: Automatic Updates. To sweeten the deal even 
further, another new service, called Microsoft Update, extends the 
process to cover Microsoft software other than Windows. 

Automatic Updates 
During installation of Windows XP (or of Service Pack 2, if you 
installed it separately), you may have seen a screen like the one 
shown in Figure 39. If you selected Help Protect My PC by Turning 
on Automatic Updates Now, the Automatic Updates feature is already 
active. This means your computer connects to the Windows Update 
site in the background, downloads and installs any new updates as 
they appear, by default once a day at 3:00 A.M. 

Figure 39 
 

 

 If you turned on Automatic Updates during the Windows (or SP2) 
installation, give yourself a pat on the back. 

  If you did not turn on Automatic Updates during installation, or if 
you want to change its settings (such as how often or at what time it 
connects), choose Start > Control Panel. If the window says “Pick a 

http://update.microsoft.com/
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category,” click the Switch to Classic View link. Then double-click
the Automatic Updates icon. In the control panel that appears
(Figure 40), make any desired settings and click OK.

Figure 40 The Automatic
Updates control
panel lets you
change the
frequency and
time of checking
for new
Windows
updates.

Microsoft Update
Windows Update (along with Automatic Updates) applies only to
Windows itself and the software included with it. To extend the same
system so that it provides updates for other Microsoft software (nota-
bly Microsoft Office), turn on Microsoft Update. Follow these steps:

1. In Internet Explorer (not a third-party browser, such as Firefox),
visit http://update.microsoft.com/.

2. Next to the large message “New! Get Microsoft Update today!” is a
Start Now button (see Figure 41). Click it.

http://update.microsoft.com/
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Figure 41 
 

 

 To turn on Microsoft Update, click Start Now—and be prepared to 
click it again on the next page! 

  3. Another page appears, with another Start Now button. Click that 
too. 

4. Read the “Review the License Agreement” page and click Continue. 

Microsoft Update is now active. Assuming you also activated 
Automatic Updates, you need do nothing else; the updates will be 
downloaded according to the schedule you set in the Automatic 
Updates control panel. To check for updates immediately, click the 
Check for Updates button on the confirmation Web page. Or, to check 
for updates manually at any time, choose Start > All Programs > 
Microsoft Update. 
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Use a Firewall 
In computing terms, a firewall is a program that monitors all the 
network traffic to and from your computer and filters or blocks com-
munication based on a set of rules. For example, a firewall may allow 
you to view Web pages and send email but prevent other computers 
from accessing your files, installing new software, or hijacking your 
computer to act as a spam-sending robot. Because a great deal of 
malware gets onto Windows computers because some potentially 
harmful avenue of network access was left open, a firewall is an 
important first line of defense. 

Windows XP includes its own firewall, which is activated by default 
in Service Pack 2. This basic firewall should be adequate for most 
home users—and it provides much better protection than nothing. 
To confirm that your Windows Firewall is on, choose Start > Control 
Panel. Make sure you’re in Classic view (if not, click the Switch to 
Classic View link), and then double-click the Windows Firewall icon. 
Make sure On is selected (Figure 42). 

Figure 42 

 

“On” is the only right 
setting for the built-in 
Windows Firewall, unless 
you’ve purchased a more 
advanced firewall utility 
as a replacement. 
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Third-party firewalls offer a number of additional features, so if your 
networking needs are more advanced, try one of these firewalls: 

• Zone Alarm or Zone Alarm Pro 
http://www.zonelabs.com/ (Zone Alarm, free; Pro version, $50) 

• Kerio Personal Firewall 
http://www.sunbelt-software.com/Kerio.cfm ($20) 

• Lavasoft Personal Firewall 
http://www.lavasoft.de/ ($30) 

  
TIP One particularly useful feature of Zone Alarm Pro is that it 

protects you against software that surreptitiously watches and 
records your keystrokes (to learn your passwords or bank 
account numbers, for example). 

  

Install Anti-Virus Software 
Every Windows computer—and that includes your Mac, now that it’s 
running Windows—needs anti-virus software. No exceptions; no ifs, 
ands, or buts. Windows viruses are so numerous, virulent, and nasty 
that you’d be foolish not to avoid them if humanly possible. In fact, if 
you’re running Windows XP with SP2, you’ll see frequent reminders 
pop up on your screen if you haven’t yet installed anti-virus software. 
Microsoft (rightly) wants you to take this matter seriously. 

Numerous anti-virus programs are available, including: 

• The best known, Symantec’s Norton AntiVirus and McAfee’s 
VirusScan. I’ve used both of these products, and although they are 
effective, they’re also frequently intrusive and can in some cases 
significantly reduce your computer’s performance. 
http://www.symantecstore.com/dr/sat1/ec_dynamic.main?sp=23
&pn=3&sid=49997 ($40) 
http://us.mcafee.com/root/package.asp?pkgid=100&cid=16269 
($40 for a one-year subscription) 

• AVG from Grisoft 
http://free.grisoft.com/doc/1 (free for home use, otherwise $39 
for a two-year subscription) 

http://www.zonelabs.com/
http://www.sunbelt-software.com/Kerio.cfm
http://www.lavasoft.de/
http://www.symantecstore.com/dr/sat1/ec_dynamic.main?sp=23&pn=3&sid=49997
http://www.symantecstore.com/dr/sat1/ec_dynamic.main?sp=23&pn=3&sid=49997
http://us.mcafee.com/root/package.asp?pkgid=100&cid=16269
http://free.grisoft.com/doc/1
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• avast! antivirus 
http://www.avast.com/ (free for home use, otherwise $40 for a 
one-year subscription) 

• Clam AntiVirus 
http://www.clamav.net/ (open-source, free, and also available for 
Mac OS X) 

Of these, I’d personally lean toward AVG, but regardless of which 
package you choose, download and install some sort of anti-virus 
software right now. 

Remove and Block Spyware and Adware 
Technically a different category of software than viruses (and their 
cousins, Trojan horses and worms), spyware (or adware) runs in the 
background and monitors what you do, including which Web sites 
you visit. Usually this is for the purpose of displaying targeted ads 
(even when you don’t have a Web browser open), though more 
devious and malign uses are also possible—such as stealing your 
passwords and other sensitive data. 

The two most popular anti-spyware/adware applications at the 
moment are these: 

• Ad-Aware SE 
http://www.lavasoft.de/ (Personal version, free; Plus version, $27; 
Pro version, $40) 

• Spybot Search & Destroy 
http://www.safer-networking.org/ (free) 

Microsoft is also getting into the act. Their new Windows Defender 
application, currently in beta testing, looks promising. 
http://www.microsoft.com/downloads/details.aspx?FamilyID=435bf
ce7-da2b-4a6a-afa4-f7f14e605a0d&DisplayLang=en (free) 

Get a Better Browser 
Microsoft Internet Explorer is notoriously susceptible to malware. 
Of the many alternative browsers, Firefox has the best reputation for 
robustness and resistance to everything from viruses to pop-up win-
dows. You can download it from http://www.mozilla.com/firefox/. 
Other good options include Opera (http://www.opera.com/) and 
Mozilla (http://www.mozilla.org/download.html). 

http://www.avast.com/
http://www.clamav.net/
http://www.lavasoft.de/
http://www.safer-networking.org/
http://www.microsoft.com/downloads/details.aspx?FamilyID=435bfce7-da2b-4a6a-afa4-f7f14e605a0d&DisplayLang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=435bfce7-da2b-4a6a-afa4-f7f14e605a0d&DisplayLang=en
http://www.mozilla.com/firefox/
http://www.opera.com/
http://www.mozilla.org/download.html
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LEARN MORE

For more information about running Windows (on a Mac or other-
wise), consult these resources.

Ebooks:

Boot Camp Public Beta First Look by Ben Long
(Peachpit; 54 pages; $7)
http://www.peachpit.com/title/0321473779
This ebook includes some information on Windows configuration and
usage that goes beyond what I describe here, but it provides only a
cursory overview of Parallels.

Running Boot Camp by Chuck Toporek
(O’Reilly; 32 pages; $8)
http://www.oreilly.com/catalog/bootcamp/
This ebook focuses solely on Boot Camp, with the bulk of it covering
the details of applying firmware updates and running the installer.

Printed books:

Windows XP Home Edition: The Missing Manual by David Pogue
(O’Reilly)
http://www.amazon.com/gp/product/0596002602/

Windows XP Pro: The Missing Manual by David Pogue, Craig
Zacker, and L.J. Zacker (O’Reilly)
http://www.amazon.com/gp/product/0596008988/

Windows XP for Starters: The Missing Manual by David Pogue
(O’Reilly)
http://www.amazon.com/gp/product/0596101554/

Windows XP for Dummies, 2nd Edition by Andy Rathbone (For
Dummies)
http://www.amazon.com/gp/product/0764573268/

http://www.peachpit.com/title/0321473779
http://www.oreilly.com/catalog/bootcamp/
http://www.amazon.com/exec/obidos/redirect?tag=interesthingo-20&path=tg/detail/-/0596002602
http://www.amazon.com/exec/obidos/redirect?tag=interesthingo-20&path=tg/detail/-/0596008988
http://www.amazon.com/exec/obidos/redirect?tag=interesthingo-20&path=tg/detail/-/0596101554
http://www.amazon.com/exec/obidos/redirect?tag=interesthingo-20&path=tg/detail/-/0764573268
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APPENDIX A: WINDOWS ON A POWERPC MAC 

Even if you have an older Mac with a PowerPC processor, you can still 
run Windows, albeit slowly. I’m aware of three software packages that 
support running Windows XP as a virtual machine under Mac OS X 
10.4 on a PowerPC Mac. The problem is that the software still has to 
translate instructions so that they can be understood by a different 
processor, and all that translation takes time. Even with a top-of-the-
line PowerPC Mac and the most highly optimized virtualization 
software, the performance of Windows will be less than stellar. If you 
happen to have a slower Mac and a less capable software package, 
performance can be downright abysmal. 

That said, if you need to use Windows only occasionally, and if you 
don’t plan to run processor-intensive tasks (such as games and video 
editing software), you may find one of these solutions perfectly 
acceptable. 

• Virtual PC for Mac: This is the best-known and most reliable 
emulation software for running Windows on a PowerPC Mac.  
http://www.microsoft.com/mac/products/virtualpc/virtualpc.aspx 
($249) 

• GuestPC: Regarded by some as superior to Virtual PC and by 
others as unusably slow, GuestPC has fewer features, but also less 
overhead—not to mention a lower price. Unlike Virtual PC, you 
can’t get it bundled with Windows, though; you must buy 
Windows separately.  
http://www.lismoresystems.com/en/ ($70) 

• Q: In the Intel version of Q, Windows runs slowly; in the PowerPC 
version, it walks. Well, saunters.  
http://www.kberg.ch/q/ (free) 

http://www.microsoft.com/mac/products/virtualpc/virtualpc.aspx
http://www.lismoresystems.com/en/
http://www.kberg.ch/q/
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